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Apresentação

O Inventário Florestal Nacional do Brasil (IFN-BR) visa fundamentar a formulação e implementação 
de	políticas	públicas	de	desenvolvimento,	uso	e	conservação	dos	recursos	florestais,	bem	como	a	
gestão	desses	recursos,	por	meio	de	informações	suficientes,	confiáveis	e	periodicamente	atuali-
zadas, coletadas no campo. Estudos em escala de paisagem, por sua vez, também têm adquirido 
importância fundamental dentro desse contexto, por permitirem a avaliação da dinâmica de uso e 
cobertura da terra e das interações entre padrões espaciais e processos ecológicos, envolvendo 
florestas	e	outros	usos	da	terra,	como	a	agricultura.	

Por sua vez, a Política Nacional de Meio Ambiente no Brasil tem por objetivo a preservação, me-
lhoria e recuperação da qualidade ambiental propícia à vida, visando assegurar, no país, condições 
ao desenvolvimento socioeconômico, aos interesses da segurança nacional e à proteção da digni-
dade da vida humana. Dessa maneira, o objetivo geral da Política Nacional do Meio Ambiente está 
dividido em preservação, melhoramento e recuperação do meio ambiente. Para poder implemen-
tar ações relativas a tais objetivos requer-se instrumentos de diagnóstico e análise que permitam 
mapear e avaliar ecossistemas e os respectivos serviços que proveem em seus territórios, ambos 
espacialmente explícitos. Daí advém a necessidade de incluir dados e indicadores espaciais na 
análise. Nessa avaliação, torna-se também necessário traduzir o resultado de abordagens técnico-
-científicas	em	informação	compreensível	para	a	implementação	de	políticas	públicas	e	tomada	de	
decisão,	o	que	pode	ser	feito	por	meio	de	mapas,	indicadores,	relatórios	e	gráficos.

Assim, a Embrapa Florestas desenvolveu, em conjunto com o Serviço Florestal Brasileiro (SFB) e 
com o suporte da Food and Agriculture Organization of the United Nations (FAO), uma metodologia 
para a análise espacial da estrutura da paisagem, no contexto do IFN-BR. O objetivo do denomina-
do Componente Geoespacial dentro do projeto do IFN-BR, ao longo das diferentes edições, é ob-
servar	a	dinâmica	de	uso	das	florestas	por	meio	de	imagens	orbitais,	em	escalas	compatíveis	com	
os interesses nacionais e estaduais e utilizando, para tanto, indicadores como mudanças no uso da 
terra	e	fragmentação	florestal.	De	tal	maneira,	pretende-se	produzir	informações	sobre	a	importân-
cia	e	qualidade	dos	recursos	florestais	em	relação	a	outros	usos	da	terra,	em	escala	de	paisagem,	
ressaltando suas funções, qualidade e pressões incidentes, de modo a subsidiar a formulação de 
políticas públicas que sejam apropriadas à região e à sua escala de abordagem. 

A análise da paisagem complementa outros dois componentes do IFN-BR, a coleta de dados em 
campo e o levantamento socioeconômico, além de ser destinada ao monitoramento do componente 
florestal	em	escala	de	paisagem,	ao	longo	do	tempo.	Nesse	contexto	estão	inseridas	as	chama-
das Unidades Amostrais de Paisagem (UAPs), por meio das quais é implementado o Componente 
Geoespacial do IFN-BR, concebidas para oferecer um ferramental que permita ao usuário a visuali-
zação de aspectos da paisagem conjugados sob a forma de indicadores e seus respectivos índices. 
As UAPs são áreas amostrais permanentes de 100 km², distribuídas sistematicamente em um grid 



de 40 km x 40 km sobre todo o território nacional, perfazendo um total de aproximadamente 5.500 
unidades. Todas contêm uma Unidade Amostral de Campo do IFN-BR, na forma de um conglome-
rado, localizada em seu centro geométrico. Dessa maneira, a estratégia adotada foi desenvolver a 
metodologia de todos os componentes do IFN-BR com vistas à sua integração e posterior análise 
conjunta.

Uma vez que proporcionam a possibilidade de análises estáticas, ou seja, em apenas uma ocasião, 
ou dinâmicas, quando os índices são calculados em sucessivas ocasiões, as UAPs constituem 
unidades de diagnóstico e de monitoramento. A base para o cálculo dos índices de paisagem e pos-
teriores	análises	é	o	mapa	de	uso	e	cobertura	da	terra,	obtido	empregando-se	processos	de	classifi-
cação e análise de imagens orientada a objetos, seguindo os procedimentos descritos por Luz et al. 
(2018a, 2018b). Assim, os indicadores e índices de paisagem permitem estabelecer um diagnóstico 
integrado	de	cada	UAP,	que,	por	sua	vez,	reflete	uma	determinada	combinação	de	características	
biogeoclimáticas	(classe	territorial	ou	ecorregião),	associadas	a	fatores	de	influência	antrópicos	ou	
naturais, ocorrentes naquela localidade.

O uso e a combinação de mais de um grupo de indicadores e índices é altamente recomendável por 
fornecer mais informações para a conservação da paisagem (Lindenmayer et al., 2008), uma vez 
que	apenas	o	mapeamento	do	uso	e	cobertura	da	terra	por	si	só,	e	a	quantificação	das	respectivas	
superfícies	não	proveem	informações	sobre	o	padrão	da	paisagem	florestal,	sua	fragmentação	e	co-
nectividade. De fato, nenhuma medida única, analisada isoladamente, pode capturar integralmente 
a complexidade do arranjo espacial dos fragmentos em uma paisagem (Estreguil et al., 2014). De 
tal maneira, um conjunto de índices constitui uma ferramenta para o planejamento estratégico da 
paisagem,	e	a	possibilidade	de	se	quantificar	avanços	no	estabelecimento	de	determinadas	políti-
cas	voltadas	à	gestão	territorial	e	ao	uso	e	conservação	de	florestas.

Foram estabelecidas sete categorias de indicadores de qualidade da paisagem de acordo com o 
objeto ou tema de análise. Dessa maneira, os indicadores da qualidade da paisagem se referem à 
sua composição (ocupação das classes de uso e cobertura da terra), morfologia (categorização 
dos	padrões	morfológicos	do	habitat	florestal),	mosaico (categorização da vizinhança das classes 
de uso e cobertura da terra), similaridade de habitats adjacentes (categorização da interface de 
bordas do habitat natural com outras classes de uso e cobertura da terra), conectividade (determi-
nação do grau de conexão existente entre fragmentos de habitat natural e simulação de cenários 
representando	o	incremento	na	conectividade	com	base	na	restauração	florestal),	fragmentação 
(determinação do grau de fragmentação do habitat natural) e zonas ripárias (avaliação da pressão 
antrópica	a	que	estão	submetidos	os	remanescentes	de	habitat	florestal	nas	zonas	ripárias).	

A combinação linear desses índices gera um score único por UAP, o que permite estabelecer com-
parações entre elas e propor ações de recuperação, manutenção, ou melhoria da qualidade do 
componente	florestal,	relativas	a	determinados	aspectos	da	paisagem.	Além	disso,	os	índices	po-
dem ser fornecidos tanto individualmente para cada UAP como sumarizados por estratos (ecorre-
giões, ou, unidades político-administrativas, por exemplo).

O presente manual se atém à descrição detalhada dos procedimentos relativos ao cálculo e análise 
do	conjunto	de	índices	que	irão	gerar	o	diagnóstico	final	das	UAPs.

Sérgio Gaiad
Chefe Adjunto de Pesquisa e Desenvolvimento
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1 Análise de paisagem

A base para o cálculo dos índices de paisagem e posteriores análises, que serão descritas nos 
itens subsequentes deste manual, é o mapa de uso e cobertura da terra, obtido empregando-se a 
metodologia descrita no Manual de Análise de Paisagem Vol. 1: Procedimentos para a execução do 
mapeamento de uso e cobertura da terra (Luz et al., 2018a) e cuja acurácia deve ter sido avaliada 
seguindo os padrões descritos no Manual de Análise de Paisagem Vol. 2: Procedimentos para a 
execução do controle de qualidade do mapeamento de uso e cobertura da terra (Luz et al., 2018b). 
Os	exemplos	de	mapas,	figuras,	índices	e	tabelas	mostrados	no	presente	manual	foram	baseados	
nos resultados de Unidades Amostrais de Paisagem (UAPs), analisadas em um estudo-piloto para 
o estado do Paraná.

O arquivo shapefile correspondente ao mapa de uso e cobertura da terra deve conter em sua tabe-
la de atributos duas colunas principais: “LULC”, contendo o código numérico de cada classe para 
todos os polígonos, e “AREA_ha”, com o cálculo das áreas para todos os polígonos, apresentadas 
em hectares, e calculadas utilizando-se a Projeção Cônica Equivalente de Albers, em virtude de ser 
esta	a	projeção	apropriada	para	tal	finalidade	(IBGE,	2016),	e	adotando	o	Sistema	de	Referência	
Geocêntrico para as Américas (SIRGAS2000), com os seguintes parâmetros para o país: Longitude 
origem: -54°; Latitude origem: -12°; Paralelo padrão 1: -2°; Paralelo padrão 2: -22°.

1.1 Composição da paisagem 

O primeiro elemento abordado na análise de paisagem corresponde à sua composição, que deriva 
diretamente	do	mapa	de	uso	e	cobertura	da	terra	de	cada	UAP.	A	classificação	gerada	por	meio	da	
segmentação orientada a objeto, além de permitir avaliar a frequência e a distribuição dos tipos de 
uso e cobertura que ocorrem em cada UAP, é um elemento essencial para as demais análises que 
aqui serão apresentadas. O mapeamento contempla onze classes de uso e cobertura da terra, que 
foram	divididas,	para	fins	da	análise	espacial	que	considera	conceitos	da	ecologia	de	paisagens,	
em	duas	grandes	categorias,	de	acordo	com	o	grau	de	influência	antrópica.	A	primeira	inclui	áreas	
de	cobertura	arbórea	ou	arbustiva,	por	se	tratar	de	um	inventário	florestal,	com	vegetação	natural,	
de maior interesse para a ecologia e a conservação da natureza, denominado “primeiro plano”, do 
termo em inglês foreground, conforme adotado na literatura relacionada (Wickham et al., 2010; 
Soille; Vogt, 2009; Estreguil et al., 2014; Vogt e Riitters, 2017). As seguintes classes estão incluídas 
nessa grande divisão: Floresta Natural, Outras Terras com Vegetação Lenhosa e Outras Terras com 
Árvores. Em “segundo plano” (ou background) estão as demais classes, que correspondem à matriz 
da paisagem em estudos de ecologia de paisagens, exceto as grandes massas d’água e a classe 
espectral de áreas não observadas, composta por pixels onde houve obstruções ou impedimentos 
à	 identificação	ou	 imageamento	do	objeto	na	superfície	 terrestre.	Uma	breve	descrição	de	cada	
classe pode ser vista na Tabela 1. A tonalidade das cores adotadas, seus respectivos valores no 
modelo	de	cores	RGB	e	a	codificação	a	ser	adotada	na	tabela	de	atributos,	utilizados	para	a	legenda	
de cada classe do mapeamento, são apresentados na Tabela 2. Para um maior detalhamento das 
classes deve-se consultar o Manual de Análise de Paisagem Vol. 1: Procedimentos para a execu-
ção do mapeamento de uso e cobertura da terra (Luz et al., 2018a).

Na Figura 1 podem-se observar tanto os polígonos gerados por meio da segmentação da imagem 
(a), sobrepostos ao mosaico das imagens RapidEye (RE) que recobrem a área da UAP1214, bem 
como o mapa resultante (b) e a legenda das diferentes classes consideradas no mapeamento (c).
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Tabela 1.	Descrição	e	codificação	das	classes	de	uso	e	cobertura	presentes	nas	UAPs.

Classe Símbolo/código Descrição

Floresta Natural F
01

Áreas estendendo-se por mais do que 0,5 ha ocupadas por árvores de mais 
de 5 m de altura, com uma cobertura de copa maior do que 10%, ou árvores 
capazes de atingir estes limiares in situ (FAO, 2012), de origem natural. Não 
incluem	áreas	de	uso	predominantemente	agrícola	ou	urbano.	São	definidas	
tanto pela presença de árvores quanto pela ausência de outros usos da terra 
predominantes.

Outras Terras 
com Vegetação 
Lenhosa

VL
02

Áreas	não	classificadas	como	florestas,	que	se	estendem	por	mais	de	0,5	ha,	
com árvores maiores do que 5 m e cobertura de copas entre 5% e 10%; ou 
árvores capazes de atingir estes limiares in situ; ou com uma combinação de 
indivíduos arbóreos, arbustivos e de árvores com mais de 10% de cobertura 
do dossel (FAO, 2012).

Outras Terras com 
Árvores

OTA
03

Contempla árvores isoladas, ou agrupadas, que não se enquadram na 
definição	de	floresta,	ocorrendo	associadas	a	outros	usos,	como	áreas	de	
agricultura	e	pastagem,	ou	 influência	urbana.	Correspondem	a	áreas	que	
tenham abrangência superior a 0,05 ha (500 m2) e inferior a 0,5 ha (5.000 m2).

Gramíneas e 
Herbáceas

C
04

Áreas naturais, caracterizadas por um estrato predominantemente herbáceo, 
com eventual ocorrência de elementos arbóreo/arbustivo, desde que 
esparsamente distribuídos, sobre um tapete gramíneo-lenhoso. Encontram-
se	 disseminadas	 por	 diferentes	 regiões	 fitogeográficas,	 compreendendo	
diferentes tipologias, com diversos graus de antropização (IBGE, 2013).

Floresta Plantada R
05

Classe relativa aos plantios ou formações de maciços com espécies 
florestais	nativas	ou	exóticas,	puros	ou	consorciados.	Nesta	definição	não	
se considera se o plantio é realizado em áreas anteriormente povoadas com 
espécies	 florestais	 ou	 não;	 considera-se	 como	 floresta	 plantada	 todas	 as	
áreas	povoadas	com	essências	florestais,	independentemente	do	ambiente.	
Incluí	estradas	florestais,	barreiras	de	proteção	contra	incêndios	e	quebra-
ventos.

Solo Exposto S
06

Áreas	sem	cobertura	vegetal,	devido	a	influência	antrópica,	podendo	estar	
ocupadas por atividades de mineração, exploração de jazidas, lavras, bem 
como áreas de extração de areia.

Agricultura e 
Pastagem

A
07

Áreas	 utilizadas	 para	 a	 produção	 de	 alimentos,	 fibras	 e	 commodities do 
agronegócio, incluindo todas as terras cultivadas, ou em descanso, podendo 
também compreender áreas alagadas (IBGE, 2013) que sejam utilizadas 
para	essa	mesma	finalidade.	Classe	 constituída	por	 culturas	 temporárias,	
cíclicas	 e	 permanentes.	 Inclui,	 ainda,	 as	 plantas	 hortícolas,	 floríferas,	
medicinais, aromáticas e condimentares de pequeno porte. Inclui lavouras 
semipermanentes e plantios lenhosos perenes, como os de frutíferas 
(pomares).

Influência	Urbana U
08

A essa nomenclatura estão associados os tipos de uso da terra de natureza 
antrópica	 intensiva,	 estruturadas	 por	 edificações	 e	 sistema	 viário,	 onde	
predominam	as	 superfícies	 artificiais	 não	 agrícolas.	Estão	 incluídas	 nesta	
categoria as metrópoles, cidades, vilas, áreas de rodovias, serviços e 
transporte, energia, comunicações e terrenos associados, bem como 
edificações	presentes	no	meio	rural	(casas,	galpões,	estábulos,	entre	outras).

Superfície com 
Água1

H
09

Áreas compostas pelo oceano, rios, lagos, lagoas, barragens, represas, 
canais	naturais	ou	artificiais,	tanques	d’água,	com	área	igual	ou	superior	a	
um hectare.

Dunas e 
Afloramentos	
Rochosos

D
10

Áreas referentes a ambientes naturais, sem cobertura vegetal, como 
afloramentos	rochosos,	praias,	dunas	e	extensões	de	areia	ou	seixos	(IBGE,	
2013).

Área não 
observada

NO
00

Área de desinformação, não observada por impedimentos tais como erro no 
sistema de imageamento, obstruções como nuvens e sombra de nuvens e 
demais condições de observação desfavoráveis.

1	A	base	hidrográfica	fornecida	como	insumo	serve	de	orientação	e	referência	para	a	delimitação	e	classificação	dos	elementos	constantes	na	classe	“Su-
perfície com água”. Todos os rios de margem dupla que constam nesse insumo deverão constar nessa classe
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Tabela 2.	Codifi	cação	dos	atributos,	tonalidade	de	cores	e	valores	no	modelo	RGB	adotados	na	legenda	das	classes	para	
a elaboração do mapa de uso e cobertura da terra.

Valor	de	codifi	cação Classe de uso e cobertura R G B Cor

01 Floresta Natural 115 178 115

02 Outras Terras com Vegetação 
Lenhosa 190 231 150

03 Outras Terras com Árvores 155 074 079

04 Gramíneas e Herbáceas 215 194 158

05 Floresta Plantada 137 137 068

06 Solo Exposto 232 190 255

07 Agricultura e Pastagem 247 247 198

08 Infl	uência	Urbana 204 204 204

09 Superfície com Água 113 132 201

10 Dunas	e	Afl	oramentos	Rochosos 240 210 220

00 Área não Observada 255 255 255

Figura 1.	Polígonos	de	uso	e	cobertura	da	terra,	originados	pela	classifi	cação	orientada	a	objetos	para	a	UAP1214	(a),	
localizada no município de Paranaguá, PR, bem como o mapa de uso e cobertura da terra (b) e a respectiva legenda das 
classes (c).

 
  

(a) (b)

(c)
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Figura 2. Percentual de área ocupada por cada classe de uso e cobertura dentro da UAP1214. 

1.1.1 Frequência e distribuição das classes de uso e cobertura da terra na paisagem

Com base no mapa de uso e cobertura da terra de cada uma das UAPs, podem ser analisadas a 
frequência e a distribuição dos tipos de uso e cobertura que ocorrem em cada uma delas. Estes 
resultados	podem	ser	apresentados	na	forma	de	gráficos,	contendo	valores	percentuais	da	área	
ocupada por cada classe, como demonstrado na Figura 2, utilizando como exemplo a UAP1214.

Para obtenção do percentual de ocupação de cada classe de uso e cobertura na paisagem, pode-se 
utilizar o programa ArcMap,	conforme	apresentado	na	sequência,	que	exemplifica	o	processo	por	
meio da versão 10.4.1 (outros programas, como o QGIS, por exemplo, podem ser utilizados para a 
mesma	finalidade):

a. Carregar o mapa de uso e cobertura da terra no ArcMap.

b. Abrir a tabela de atributos da camada, clicando com o botão direito do mouse no arquivo loca-
lizado na “Table Of Contents” e selecionando a opção “Open Attribute Table”.

c. Na tabela de atributos, clicar com o botão direito em qualquer uma das colunas e selecionar a 
ferramenta “Summarize” (Figura 3 (a)).

d. Uma nova janela será aberta. Deve-se, então, em “Select a field to summarize”, selecionar 
o campo “LULC”, e em “Choose one or more summary statistics to be included in the output 
table” escolher a opção “Sum” para o campo “AREA_ha”, da maneira como ilustrado na Figura 
3 (b).

 
Área (%)

C
la

ss
es

 d
e 

us
o 

e 
co

be
rt

ur
a 

da
 te

rr
a



21Manual de Análise de Paisagem: volume 3: Procedimentos para a geração de Índices Espaciais das Unidades Amostrais de Paisagem

 

1.1.2 Índices de composição da paisagem

Associados à composição espacial da UAP, são calculados dois índices adimensionais, importan-
tes para avaliar a disponibilidade de habitat e a facilidade de adaptação das espécies em relação à 
perda	de	habitats	florestais,	expressos	em	percentagem	e	com	amplitude	de	zero	a	100%:

1. Proporção de cobertura arbórea/arbustiva: Inclui as classes “Floresta Natural”, “Outras 
Terras com Vegetação Lenhosa” e “Outras Terras com Árvores”, correspondendo somente às 
áreas contempladas por classes com cobertura arbórea e/ou arbustiva.

2. Proporção de outras áreas naturais/seminaturais: Inclui as classes “Gramíneas e 
Herbáceas” e “Floresta Plantada”.

No caso da UAP1214, por exemplo, a proporção de cobertura arbórea/arbustiva contempla 66,11% 
da paisagem desta unidade amostral (“Florestal Natural” – 65,99%; “Outras Terras com Vegetação 
Lenhosa” – 0% e; “Outras Terras com Árvores” – 0,12%), enquanto a proporção de outras áreas 
naturais/seminaturais recobre 6,72%, resultante da soma das classes “Gramíneas e Herbáceas” 
(áreas naturais – 6,72%) e “Floresta Plantada” (áreas seminaturais – 0%).

1.1.3 Taxonomia da paisagem

A	taxonomia,	ou	nomenclatura,	da	paisagem	representada	pela	UAP	é	definida	pelo	grau	(percen-
tagem) de presença de cada classe de uso e cobertura. Assim, existem quatro possíveis graus de 
presença:

•	Presença Matricial: quando o grau de presença de uma das classes é superior a 50% do 
território.

Figura 3. Janelas do software ArcMap, ilustrando os passos para a seleção da ferramenta “Summarize” (a) para o cálculo 
da frequência das classes de uso e cobertura nas UAPs (b).

 

(a) (b)
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•	Presença Essencial: quando o grau de presença oscila entre 25% e 50% do território.

•	Presença Marginal: quando o grau de presença oscila entre 5% e 25% do território.

•	Presença Residual: quando o grau de presença é inferior a 5% do território.

A nomenclatura da paisagem da UAP deve obedecer às seguintes regras:

•	A classe predominante, ou seja, a de maior presença, dará o nome à paisagem. Assim, as pai-
sagens poderão ser florestais (predominância das classes “Floresta Natural” – F ou “Floresta 
Plantada” – R ou “Outras Terras com Vegetação Lenhosa” – VL ou “Outras Terras com Árvores” 
- OTA), agrícolas (predominância da classe “Agricultura e Pastagem” – A), campestres (pre-
dominância da classe “Gramíneas e Herbáceas” – C), ou urbanas (predominância da classe 
“Influência	Urbana”	–	U).

•	Quando há uma classe de uso com presença matricial (mais de 50% da área) o nome será 
definido	por	essa	classe,	acompanhado	do	termo	“matricial”	e	seguido	pelo	nome	da	classe	
essencial, se houver. Caso haja mais de uma classe essencial, o nome incluirá apenas a classe 
de uso matricial seguido dos termos “matricial” e “mista”.

•	Se	não	houver	classe	de	presença	matricial,	o	nome	é	definido	em	função	da	classe	de	uso	
essencial (entre 25% e 50% de presença) predominante, seguido da palavra “não matricial”. 
Se houver duas classes de uso essenciais, a paisagem deve incluir em seu nome a segunda 
classe de uso. Se houver três classes de uso essenciais, a paisagem é denominada apenas a 
partir da primeira classe de uso, e deve incluir os termos “não matricial” e “mista”. Exceções a 
essa	regra	são	as	paisagens	florestais,	em	que	as	letras	F	(“Floresta	Natural”)	e	R	(“Floresta	
Plantada”) são consideradas equivalentes.

Utilizando como exemplo a paisagem da UAP 1214, que possui 65,99% de Floresta Natural (F); 
6,72% de Gramíneas e herbáceas (C); 7,69% de agricultura e pastagem (A); 13,18% de área ur-
bana (U); 0,36% de solo exposto (S) e 5,88% de superfícies com água (H); ou seja, nenhuma 
classe com presença essencial, a paisagem da UAP1214 será denominada “Paisagem Florestal 
Matricial”, com a notação descrita na Tabela 3:

Tabela 3. Exemplo de taxonomia de paisagem aplicada aos dados da UAP1214.

Matricial Essencial Marginal Residual Classe
F - UHAC OTA S R D F

Nome da paisagem: Florestal Matricial

F:	floresta	natural;	OTA:	outras	terras	com	árvores;	R:	floresta	plantada;	C:	gramíneas	e	herbáceas;	A:	agricultura	e	pastagem;	S:	solo	exposto;	U:	influência	
urbana;	H:	superfícies	com	água;	D:	dunas	e	afloramentos	rochosos.

1.2 Análise morfológica de padrões espaciais 

A partir do mapa de uso e cobertura da terra deve ser realizada a Análise Morfológica de Padrões 
Espaciais - (Morphological Spatial Pattern Analysis - MSPA), implementada por Soille e Vogt 
(2009) do programa denominado GuidosToolbox (Graphical User Interface for the Description of 
image Objects and their Shapes,	ou	Interface	Gráfica	ao	Usuário	para	a	Descrição	de	Objetos	de	
Imagem e suas Formas) (Vogt, 2016b), cedido pelo JRC (Joint Research Centre of the European 
Commission). 
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A metodologia aplicada para essa análise consiste de uma sequência de operadores morfológicos 
matemáticos voltados à caracterização da distribuição espacial dos componentes de uma imagem. 
A abordagem baseia-se na segmentação dos objetos que estão em primeiro plano, ou foreground 
em uma dada imagem binária, dividindo-os em sete classes genéricas (Soille; Vogt, 2009; Wickham 
et al., 2010). O procedimento vai atribuir a cada um dos pixels do foreground uma e apenas uma 
das classes de feições geométricas mutuamente exclusivas. Este princípio implica que, em primeiro 
lugar, a cobertura espacial da imagem de entrada e as classes resultantes é idêntica, e segundo, a 
abordagem é uma verdadeira segmentação matemática devido à atribuição de classes mutuamente 
exclusivas que compreendem a área do foreground. 

1.2.1 Preparação dos dados para a MSPA 

Para a utilização das ferramentas contidas no aplicativo GuidosToolbox é necessária a preparação 
do mapa de uso e cobertura da terra, de acordo com as premissas estabelecidas pelo desenvolve-
dor. Os dados de entrada devem estar em formato raster (grid) do tipo byte (8-bit) e devem, obriga-
toriamente, conter duas classes de dados, o foreground (primeiro plano) e o background (segundo 
plano). Podem conter, também, a classe de dados ausentes (ou “missing data”). A segmentação 
MSPA será realizada na classe foreground e a classe de dados ausentes será ignorada durante o 
processo. 

No caso das UAPs, a classe de foreground deve representar as áreas cobertas pelas classes 
“Floresta Natural”, “Outras Terras com Vegetação Lenhosa” e “Outras Terras com Árvores”. As de-
mais classes de uso e cobertura da terra são representadas como o background, com exceção de 
grandes	massas	d’água.	Essas	devem	ser	excluídas	da	análise,	utilizando-se	os	valores	de	codifi-
cação	para	dados	ausentes,	já	que	podem	constituir	barreiras	totais	ou	parciais	ao	fluxo	gênico	da	
flora	e	da	fauna	na	paisagem	(Jaeger	et	al.,	2011).	Dessa	forma,	não	serão	criadas	conexões	sobre	
estas	áreas,	evitando-se	a	criação	de	conexões	entre	ilhas	ou	fragmentos	florestais	sobre	corpos	
d’água. 

A	codificação	da	imagem	deve,	portanto,	seguir	o	padrão	definido	por	Soille	e	Vogt	(2009)	e	Vogt 
(2016b), de acordo com o objetivo da análise de paisagem das UAPs esquematizado na Tabela 
4. Às classes “Floresta Natural”, “Outras Terras com Vegetação Lenhosa” e “Outras Terras com 
Árvores” deve ser atribuído o valor de pixel igual a “2”, enquanto às demais classes de uso e cober-
tura deverão ser atribuídos valores iguais a “1” (com exceção das grandes massas d’água ou áreas 
não observadas), compondo o background (o que inclui a classe “Floresta Plantada”). Em locais 
de ocorrência das grandes massas d’água, ou pertencentes à classe de “Área não Observada”, 
devem ser atribuídos valores iguais a “0”, reservados aos dados ausentes (missing data), conforme 
demonstrado na Tabela 4.

Tabela 4.	Codificação	das	classes	de	uso	e	cobertura	da	terra	nas	UAPs	de	acordo	com	as	classes	para	a	MSPA.	

Classes de uso e cobertura da terra Classes da análise 
MSPA

Valor	de	codificação	
das imagens Obrigatoriedade

Regiões onde não há disponibilidade de dados 
ou corpos d’água

Dados ausentes 
(missing data)

0 Opcional

“Floresta plantada” e demais classes de uso e 
cobertura 

Segundo plano 
(background)

1 Obrigatório

“Floresta Natural”, “Outras Terras com 
Vegetação Lenhosa” e “Outras Terras com 
Árvores”

Primeiro plano 
(foreground)

2 Obrigatório
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No	estudo-piloto,	para	a	codificação	da	imagem	foi	realizada	inicialmente	a	delimitação	das	mas-
sas	d’água	a	partir	das	informações	da	hidrografia	contidas	na	base	cartográfica	disponível	para	o	
Estado do Paraná, em escala 1:50.000. Nesta escala são representados como polígonos os cursos 
d’água, lagos, lagoas, represas, açudes, e viveiros de peixes com dimensões compatíveis com esta 
escala, assim como os oceanos. Não serão considerados nesta análise corpos d’água de pequenas 
dimensões, por não constituírem barreiras absolutas na paisagem, permitindo certa conexão entre 
fragmentos através de suas margens. 

O	procedimento	de	delimitação	da	massa	d’água	a	ser	considerada	e	a	codificação	da	 imagem	
de acordo com o padrão do GuidosToolbox podem ser realizados com apoio de um sistema de 
informações	geográficas	(SIG)	e	de	um	aplicativo	para	o	processamento	de	imagens	digitais,	con-
forme descrito a seguir. Serão utilizados os arquivos vetoriais contendo os polígonos de massa 
d’água e o mapa de uso e cobertura da terra, bem como o programa ArcMap	para	exemplificar	o	
processamento. 

a. Abrir no ArcMap os arquivos vetoriais do mapa de uso e cobertura da terra e o arquivo con-
tendo os polígonos de massa d’água referentes à área da UAP em questão. Caso os polígo-
nos de massa d’água estejam projetados em um sistema de referência diferente do adotado 
para o mapa de uso e cobertura da terra, como é o caso da base de dados fornecida pelo 
Instituto das Águas (SAD69/UTM22S) para o estado do Paraná, deve-se reprojetá-lo da se-
guinte maneira:

1. Na “ArcToolbox” localizar e abrir a ferramenta geral de vetores chamada “Project”, localiza-
da em “Data Management Tools > Projections and Transformations > Project”.

2. Escolher como camada de entrada o arquivo que se deseja reprojetar, adotando como 
Sistema de Referência de Coordenadas (SRC) de destino o mesmo SRC do arquivo con-
tendo as classes de uso e cobertura da terra (no caso, SRC Albers).

b. Após ambos os arquivos estarem no mesmo SRC pode-se observar, como na Figura 4, que 
a massa d’água (a) corresponde, aproximadamente, à classe corpos d’água do mapa de uso 
e cobertura da terra (b). No entanto, nessa fase, optou-se pela utilização do arquivo vetorial 

Figura 4. Arquivo contendo os polígonos de massa d’água existentes na área da UAP1214 (a) e respectivo mapa de uso 
e	cobertura	da	terra	obtido	pela	classificação	da	imagem	(b).

 

(a) (b)
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(c)

para delimitar as áreas que devem ser consideradas como barreiras na análise da fragmenta-
ção	e	conectividade	florestal.

c. Efetuar a operação de união entre os dois arquivos, por meio da ferramenta “Union” (Figura 5 
(a) (b)), obtendo-se um arquivo que inclua os limites dos polígonos de massa d’água e, tam-
bém, os atributos originais dessa camada de informação. Na Figura 5 (c) pode-se observar 
que os atributos das duas camadas de informação que foram unidas são preservados.

Figura 5. Localização da ferramenta “Union” na Caixa de ferramentas do software ArcMap (a) e janela da ferramenta para 
a entrada dos dados a serem unidos (b), bem como a tabela de atributos do arquivo resultante de tal união (c).

 

(a) (b)

 
 

d.	 Para	a	codificação	das	classes	de	uso	e	cobertura	da	terra	de	acordo	com	as	premissas	esta-
belecidas para utilização no GuidosToolbox, é necessária a criação de um novo atributo, que 
deve conter os códigos estabelecidos na Tabela 4 para cada polígono do mapa. Deve-se, en-4 para cada polígono do mapa. Deve-se, en- para cada polígono do mapa. Deve-se, en-
tão, iniciar a edição do arquivo vetorial gerado pela união dos dois anteriores, clicando-se com 
o botão direito do mouse no referido arquivo presente na “Table Of Contents”, selecionando 
a opção “Edit Features > Start Editing”. Em seguida, abrir a tabela de atributos desta camada 
de dados por meio da mesma janela, na opção “Open Attribute Table”, e selecionar a opção 
“Add Field” a partir do menu de opções da tabela de atributos. Na janela que se abre inserir 
o nome do novo atributo (“MSPA”, por exemplo), indicando o formato do dado a ser inserido 
(“Short Integer”, já que serão utilizados apenas valores inteiros entre 0 e 2), aceitar em “OK” 
e fechar a janela.
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e. Efetuar a seleção das classes “Floresta Natural”, “Outras Terras com Vegetação Lenhosa” e 
“Outras Terras com Árvores” utilizando a seleção por atributos (“Selection By Attributes”), a 
partir do menu “Selection” localizado na janela principal do ArcMap. Selecionar a camada de 
informação (Layer) a partir da qual se deseja efetuar a seleção, selecionar o método de sele-
ção “Create a new selection”, efetuar duplo clique no atributo que armazena o nome da classe 
(“LULC”) até que seu nome apareça na janela inferior “SELECT*FROM ... WHERE”. Em se-
guida, selecionar a operação desejada “=”, clicar sobre “Get Unique Values” para que sejam 
apresentados os tipos únicos de registros existentes para este atributo, ou seja, as classes de 
uso e cobertura da terra. Efetuar duplo clique sobre o código “1”, que corresponde à classe 
“Floresta Natural”, até que seu nome apareça na janela inferior, logo após o sinal “=”. Para 
selecionar as outras classes de interesse, clicar uma vez sobre o operador “OR” e novamente 
efetuar um duplo clique sobre o atributo que armazena o nome da classe (“LULC”), dessa vez 
selecionando o código “2”, que corresponde à classe “Outras terras com vegetação lenhosa”. 
Repetir o mesmo procedimento, dessa vez em relação à classe de código “3” (“Outras terras 
com	árvores”).	Quando	uma	das	classes	não	aparece	na	lista,	significa	que	ela	não	ocorre	na	
UAP em questão, como no exemplo da Figura 6 (a). Clicar em “OK”.

Figura 6. Janelas do ArcMap	 demonstrando	parte	das	operações	necessárias	para	a	 codificação	do	arquivo	 vetorial	
contendo as classes de uso e cobertura da terra e as massas d’água para a UAP1214.

  

(a) (b)

f. Na tabela de atributos, já com os registros de todos os polígonos correspondentes às classes 
de cobertura arbórea e/ou arbustiva selecionados, abrir a calculadora de campo, clicando com 
o	botão	direito	do	mouse	sobre	o	atributo	“MSPA”,	que	receberá	a	codificação,	e	selecionar	
a opção “Field Calculator” (Figura 6 (b)). Na janela que se abre inserir o valor “2”, correspon-6 (b)). Na janela que se abre inserir o valor “2”, correspon- (b)). Na janela que se abre inserir o valor “2”, correspon-
dente à classe de foreground na análise MSPA e clicar em “OK” para o preenchimento deste 
atributo.

g. Na tabela de atributos, clicar sobre o botão “Switch Selection” alternando da seleção das 
classes de foreground para a seleção de todas as demais classes de uso e cobertura da ter-
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ra constantes da tabela. Utilizar novamente a ferramenta “Field Calculator” sobre o atributo 
“MSPA” para atribuir o valor “1” aos registros selecionados.

h. Utilizar novamente a ferramenta de seleção para a seleção do atributo “Tipo_Massa” da mes-
ma forma realizada anteriormente, porém, desta vez serão selecionados os polígonos sem 
atributos (“Tipo_Massa” = ‘ ‘), ou seja, aqueles que não são originários do arquivo vetorial que 
contém os polígonos de massa d’água. Inverter a seleção. Adicionar a essa seleção também 
os polígonos pertencentes à classe de uso e cobertura igual a 9 (“Superfícies com água”). 
Utilizando a calculadora de campo, atribuir o valor “0” aos registros selecionados.

i.	 Após	a	codificação	do	arquivo	vetorial	de	mapa	de	uso	e	cobertura	da	terra	e	das	massas	
d’água, deve ser gerado um arquivo em formato raster contendo, em cada pixel, o valor a ser 
utilizado nas análises do GuidosToolbox. Para tanto, selecionar a opção “Feature to Raster” 
disponível em “ArcToolbox > Conversion Tools > To Raster > Feature to Raster“ (Figura 7 (a)) 
na Caixa de Ferramentas. Utilizar como dado de entrada o arquivo vetorial resultante da união 
dos	arquivos	“mapa	de	uso	e	cobertura	da	terra”	e	“massa	d’água”,	codificados	anteriormente	
de acordo com as premissas do GuidosToolbox. Selecionar o atributo (coluna da tabela de 
atributos)	utilizado	para	codificar	os	polígonos,	bem	como	selecionar	o	nome	e	o	local	no	qual	
se deseja armazenar o arquivo gerado, estabelecer o tamanho da célula de saída igual a 5 m 
e clicar em “OK” (Figura 7 (b)).

Figura 7. Janela do ArcToolbox (a) e da ferramenta Feature to Raster (b), demonstrando passos da operação de conver-
são do formato de arquivo vetorial para o formato de arquivo raster.

 

(a)

 

(b)

j. Converter o arquivo raster gerado em formato Esri Grid para um arquivo raster em forma-
to Geotiff, exportando-o. Clicar sobre o nome do arquivo na tabela de conteúdos (Table of 
Contents) do ArcMap com o botão direito do mouse, selecionar a opção “Data > Export Data”. 
Selecionar as opções default de extensão do arquivo, referência espacial e tamanho da célula 
de acordo com o exposto na Figura 8. Selecionar a localização de armazenamento do arquivo 
a	ser	gerado,	nome	do	arquivo	e	formato	tiff,	sem	compressão	(“none”).
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1.2.2 Aplicação da abordagem MSPA

Com o arquivo formato raster preparado para uso no aplicativo GuidosToolbox, pode-se dar início à 
análise MSPA. Para instalação do programa, acessar a página da internet do Joint Research Centre 
onde se encontram depositados os arquivos de instalação, manual de utilização, exemplos e tuto-
riais de uso, efetuar download e seguir as instruções para instalação do programa em <http://forest.
jrc.ec.europa.eu/download/software/guidos/>. Depois de instalado e aberto o programa, proceder 
de acordo com as direções a seguir para a realização das análises de interesse:

a. Ao abrir o programa (duplo clique sobre o ícone ou seleção do programa a partir do menu 
iniciar),	apresenta-se	uma	janela	notificando	a	utilização	de	ferramentas	na	linguagem	IDL,	
utilizada para sua compilação. Clicar na opção “Click To Continue” para prosseguir (Figura 9 
(a)). 

 
Figura 8. Janela de exportação do arquivo em formato raster Esri Grid gerado pela ferramenta “Feature to Raster” para 
o formato raster	Geotiff.

 Figura 9. Janelas que se abrem quando 
o GuidosToolbox é inicializado. A primeira 
informa que ferramentas em linguagem 
IDL serão utilizadas, devendo-se apenas 
clicar na opção apresentada para que o 
programa inicialize (a). A segunda janela 
permite	 que	 seja	 definida	 a	 pasta	 de	
trabalho, onde estão armazenadas as 
imagens a serem analisadas (b).
Fonte: Vogt (2016a).

 

(a) (b)
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b. Assim que o programa se abre, pode ser selecionada a pasta de trabalho onde se encontram 
os arquivos que serão utilizados. Navegar nesta janela até a pasta de trabalho, clicando em 
“OK”	ao	finalizar.

c. Abrir a imagem utilizando o menu “File > Read Image > GeoTiff”, como na Figura 10 (a).

Figura 10. Janelas do GuidosToolbox. Em (a) um exemplo da tela incial do programa com a opção que permite abrir 
imagens	em	formato	geotiff.	Em	(b)	a	imagem	anteriormente	preparada	e	aberta	de	acordo	com	as	cores	para	visualização	
padrão. Em (c) podem ser visualizadas as informações da imagem. Em (d) é apresentada parte da interface que permite 
configurar	os	parâmetros	de	ajuste	para	a	análise	MSPA.	

 

(a)

 
 

(b)

(c) (d)
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d.	 A	imagem	aberta	deve	conter	apenas	os	três	valores	utilizados	na	codificação	das	classes	
realizada anteriormente, variando de 0 a 2 em números inteiros. As áreas ocupadas pelas 
classes “Floresta Natural”, “Outras Terras com Vegetação Lenhosa” e “Outras Terras com 
Árvores” devem apresentar valor igual a “2”, massas d’água e áreas não observadas, valores 
iguais	a	“0”	e,	demais	classes	de	uso	e	cobertura	da	terra,	igual	a	“1”.	Esta	confirmação	pode	
ser	realizada	verificando-se	o	valor	apresentado	logo	abaixo	da	imagem,	onde	se	encontram	
as coordenadas de imagem do pixel sob o mouse e também seu valor em bytes, como de-
monstrado na Figura 10 (b), item (1). Também podem ser consultadas informações da ima-10 (b), item (1). Também podem ser consultadas informações da ima- (b), item (1). Também podem ser consultadas informações da ima-
gem clicando sobre “Image Info”, conforme indicado na Figura 10 (b), item (2). Na janela que 
se abre são disponibilizadas informações do tipo de dado, do número de bandas da imagem, 
dos valores únicos de pixels encontrados na imagem, do número de pixels na imagem e do 
tipo de projeção em que a imagem se encontra, dentre outras (Figura 10 (c)). A imagem é 
apresentada em tons de cinza: em preto, os dados ausentes (missing data), em cinza, os 
pixels do primeiro plano (foreground) e, em branco, os pixels do segundo plano (background).

e.	 Anteriormente	ao	início	da	análise	MSPA,	devem	ser	definidos	quatro	parâmetros,	como:	1	
- o tipo de conectividade a ser adotado entre o pixel central da janela móvel e os pixels vizi-
nhos do foreground,	2	-	a	largura	de	borda	a	ser	considerada	para	os	fragmentos	florestais,	
3 - a forma de transição entre a área de habitat interior e a borda ou perfuração e 4 - a opção 
de	 identificação	dos	pixels	 internos	às	perfurações	na	área	de	habitat	 interior,	denominada	
“Intext” (Figura 10 (d)).

f. O parâmetro conectividade do foreground determina de que forma o pixel central (circulado 
em vermelho, na Figura 11 (a) e (b)) é considerado conectado aos seus pixels vizinhos e adja-11 (a) e (b)) é considerado conectado aos seus pixels vizinhos e adja- (a) e (b)) é considerado conectado aos seus pixels vizinhos e adja-
centes, enquanto a janela móvel de dimensão 3 x 3 pixels desloca-se sobre a imagem durante 
seu processamento. A conectividade pode se dar quando um pixel de borda e um pixel da 
diagonal são comuns (conectividade em 8) (Figura 11 (a) e (c)) ou quando apenas o pixel de 
borda é comum (conectividade em 4) (Figura 11 (b) e (d)). A Figura 11 apresenta os dois tipos 
de conectividade e o seu impacto nos resultados da segmentação realizada na MSPA. O va-
lor padrão do programa para o parâmetro Conectividade do Foreground é 8, sendo, portanto, 
este valor adotado na análise das UAPs.

 

Figura 11. Parâmetro conectividade do foreground e o impacto da aplicação das suas variações na análise MSPA. Exem-
plos e aplicação de conectividade em 8 ((a) e (c) respectivamente) e conectividade em 4 ((b) e (d) respectivamente), de 
acordo com as classes da MSPA (e). 
Fonte: Vogt (2016b).

 

(a) (b)

(e)

 

(c)

 

(d)
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Figura 12. Resultados da variação do parâmetro Largura de Borda (Edge Width), quando a distância aplicada é igual a 1 
(a), 2 (b) ou 3 pixels (c), de acordo com as classes MSPA (d).
Fonte: Vogt (2016a).

g.	 O	segundo	parâmetro	a	ser	definido	previamente	à	análise	MSPA	é	o	parâmetro	de	Largura	de	
Borda (Edge Width Parameter) (Figura 12),	que	define	a	largura	ou	espessura	das	classes	que	
não	correspondem	à	área	“core”	da	floresta,	ou	seja,	que	não	correspondem	à	área	de	habitat	
interior.	Para	sua	definição,	deve	ser	considerada	a	distância	na	qual	as	espécies	da	floresta	
estão submetidas aos efeitos de borda, de acordo com as particularidades das espécies de 
interesse	e	do	bioma	em	questão,	devendo	ser	definido	em	número	de	pixels.	A	distância	real	
deve, portanto, ser dividida pela resolução espacial do dado de entrada, resultando no número 
de	pixels	que	correspondem	à	borda	da	floresta.	No	caso	da	análise	MSPA	aplicada	às	UAPs	
será adotada a largura de borda (Edge Width) igual a 30 m, de acordo com Tejera et al. (2012), 
correspondente a 6 pixels no caso das imagens RE, que têm resolução espacial de 5 m.

h. O terceiro parâmetro a ser utilizado na análise MSPA refere-se aos pixels de transição, que 
são aqueles pixels de uma borda (Edge) ou perfuração (Perforation) onde a área de habitat 
interior (Core) intercepta uma alça (Loop) ou uma ponte (Bridge).	Se	a	transição	é	definida	
como 0 (não mostrar pixels de transição), então perfurações e bordas serão apresentadas 
como fronteiras fechadas delimitando áreas de habitat interior. Percebe-se, na Figura 13, que 
uma alça (Loop) ou uma ponte (Bridge) igual a 2 pixels de extensão não será visível para esta 
configuração,	já	que	estará	escondida	sob	a	borda	ou	perfuração.	A	configuração	padrão	do	
programa é a de exibir os pixels de transição (valor igual a 1) de forma a ilustrar as conexões 
detectadas. Para Parâmetros de Largura de Borda maiores, os conectores e as áreas cober-
tas por pixels de transição aumentam de forma acentuada. Enquanto estes resultados são 
matematicamente corretos, podem parecer confusos ao usuário menos experiente. Na Figura 
13 pode-se perceber que, quando o parâmetro de transição está desativado (valor igual a 0 
no campo “Transition” da Figura 10 (d)), as perfurações (em amarelo, Figura 13 (a)) na parte 
superior da imagem estão ocultas sob os pixels de borda (em preto, Figura 13 (b)). Os valores 
dos	pixels	resultantes	da	segmentação	MSPA	são	independentes	da	seleção	da	configuração	
referente à Transição, sendo apenas aplicadas cores diferentes na visualização da imagem. O 
valor padrão igual a “1” para transição, conforme padrão do programa, deve ser adotado para 
a análise das UAPs.

 

(a) (b)

(d)

 
  

(c)
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i. O Parâmetro Intext permite distinguir feições internas e externas (Figura 13 (c) e (d)). Feições 
internas	são	definidas	por	estarem	envoltas	por	uma	perfuração,	ou	seja,	uma	clareira	na	flo-
resta, limitadas pela borda da clareira. O padrão do programa é o de permitir esta distinção, 
adicionando um segundo conjunto de classes às sete classes originais, e deve ser adotado 
na	análise	das	UAPs.	Todas	as	classes,	com	exceção	da	perfuração,	que	por	definição	é	in-
variavelmente uma classe interna, podem ser caracterizadas como internas ou externas. 

Os resultados da segmentação da imagem são visualizados de acordo com a legenda apresentada 
na Tabela 5, que inclui as sete classes de padrões para o foreground, a cor cinza para o background 
e a cor branca para Missing data. 

A Tabela 5 apresenta a tonalidade das cores e seus respectivos valores no modelo de cores RGB 
das classes da MSPA, para a Transição = 1. Para Transição = 0, os pixels de interseção das classes 
5b e 6b (“Loop in Edge” e “Bridge in Edge”, respectivamente) recebem cores iguais às de bordas 
(preto) e os pixels de classe 5c e 6c (“Loop in Perforation” e “Bridge in Perforation”, respectivamen-
te) recebem cores iguais às de perfurações (azul). As estatísticas em GuidosToolbox são calculadas 
com relação às cores da imagem. Por conseguinte, as estatísticas são diferentes para Transição = 
0 / 1, enquanto os valores reais da imagem são idênticos para Transição = 0 / 1.

Se o parâmetro “Intext”	é	definido	como	“0”,	então	não	há	nenhuma	distinção	entre	background in-
terno e externo e as classes da MSPA resultantes só podem ter os valores de bytes externos, descri-
tos	na	tabela	acima.	Em	vez	disso,	quando	se	utiliza	a	configuração	padrão	o	Intext é ajustado para 
1, então, e dependendo do seu arranjo espacial, todas as classes podem aparecer como internas ou 
externas. Isto, naturalmente, exclui os pixels da classe perfuração (perforation),	que,	por	definição,	
são sempre internos e, portanto, todos aparecem com um valor de byte igual a 105, como pode ser 
visto na Tabela 5 e na Figura 13 (c), quando Intext	é	definido	como	1.

Em resumo, o resultado visual pode ter um total de até sete cores para o foreground além da cor 
cinza para a área do background e da cor branca para áreas de dados faltantes. Os valores de 
pixels reais e únicos para a imagem quando Intext = 0 podem assumir até 13 valores (11 para o fo-
reground + 1 para o background + 1 para Missing data) e quando Intext = 1 até 24 valores (21 para 
o foreground + 2 para o background + 1 para Missing data).

Figura 13. Exemplos do resultado do Parâmetro de Transição quando ativado (a) e quando desativado (b) e Parâmetro 
Intext ativado (c) e desativado (d).
Fonte: Vogt (2016a).

 

(a) (b)

(e)

 
   

(c) (d)
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  Tabela 5. Nomes, códigos de cores e valores dos pixels (em bytes) para as classes de padrões resultantes da análise MSPA.

Classe Valor (byte) 
interno/externo R G B Cor

1a. Core (small) - habitat interior (pequeno) 116 / 16 0 255 0

1b. Core (medium) - habitat interior (médio) 117 / 17 0 200 0

1c. Core (large) - habitat interior (grande) 118 / 18 0 130 0

2. Islet - ilha de vegetação 109 / 9 160 60 0

3. Perforation - borda de clareira 105 / 5 0 0 255

4. Edge - borda 103 / 3 0 0 0

5a. Loop - alça 165 / 65 255 255 0

5b. Loop in Edge - alça em borda 167 / 67 255 255 0

5c. Loop in Perforation - alça em clareira 169 / 69 255 255 0

6a. Bridge - ponte 133 / 33 255 0 0

6b. Bridge in Edge - ponte em borda 135 / 35 255 0 0

6c. Bridge in Perforation - ponte em clareira 137 / 37 255 0 0

7. Branch - ramifi	cação 101 / 1 255 140 0

Background - segundo plano 100 / 0 220 220 220

Missing - dados ausentes 129 / 129 255 255 255

Fonte: Adaptado de Vogt (2016a).

Figura 14. Parte da janela principal do aplicativo GuidosToolbox exibindo a sequência de menus necessária para a 
ativação do cálculo de MSPA.

Defi	nidos	os	parâmetros	de	confi	guração,	pode-se	dar	início	ao	cálculo	de	MSPA,	selecionando	a	
partir do menu “Image Analysis” a opção “Pattern” e em seguida a opção “MSPA” (“Image Analysis 
> Pattern > MSPA”), conforme demonstrado na Figura 14.
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1.2.3 Resultados da análise MSPA

Após o cálculo da segmentação MSPA de acordo com o anteriormente exposto, os resultados obti-
dos	podem	ser	analisados.	O	resultado	da	segmentação	MSPA	é	apresentado	na	interface	gráfica	
do programa e também em um arquivo de texto. Como um exemplo, apresentam-se os resultados 
obtidos para a UAP1214 juntamente com observações a respeito da interpretação e análise dos 
resultados. 

a. Assim que a segmentação da imagem é concluída, a imagem resultante é apresentada na 
interface	gráfica	do	aplicativo	(Figura	15),	de	acordo	com	as	classes	MSPA	e	legenda	ante-15), de acordo com as classes MSPA e legenda ante-), de acordo com as classes MSPA e legenda ante-
riormente	indicadas.	A	imagem	pode	ser	salva	em	formato	Geotiff	utilizando-se	o	menu	“File > 
Save Image > Geotiff”.

 

b. Para salvar o arquivo de texto contendo as estatísticas da análise juntamente com a imagem 
segmentada é necessário ativar o botão “MSPA Statistics” (Figura 15, item (1)). Com este 
comando ativado, o arquivo de texto é gerado e armazenado juntamente com a imagem. Ao 
se ativar este comando, é apresentada na tabela localizada no canto inferior esquerdo da in-
terface	gráfica	a	frequência	de	cada	classe	MSPA	na	imagem.	A	primeira	coluna	(FG/data%)	
contém dois valores, sendo o primeiro relativo à frequência percentual da classe em relação 
ao total de pixels do foreground e o segundo expressa o total de pixels da imagem. A segunda 
coluna contém as frequências absolutas em número de pixels.

Figura 15. Resultados obtidos pela segmentação MSPA da área de foreground (“Floresta Natural”, “Outras Terras com 
Vegetação Lenhosa” e “Outras Terras com Árvores”) da UAP1214. 
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c. Os resultados da MSPA podem também ser divididos de acordo com as dimensões das áre-
as	de	habitat	interior	em	três	classes	de	tamanho	(pequeno,	médio	e	grande)	definidas	pelo	
usuário, ativando-se o botão “Divide” (item (1) Figura 16) e inserindo-se os valores desejados 
para os limites das classes. Pode-se perceber na Figura 16 que as áreas de habitat interior 
apresentam	tons	de	verde	diferentes,	representando	a	classificação	aplicada	de	acordo	com	
as dimensões das áreas. Neste caso, foram utilizados os limiares de 1.000 e 4.600 pixels para 
as classes que apresentam pequena (s), média (m) e grande (l) área de habitat interior (s: 
menor que 1.000 pix.; m: entre 1.000 e 4.600 pix.; g: maior que 4.600 pix.).

d. Os arquivos de texto contendo a frequência das classes de segmentação MSPA são gerados 
e	armazenados	juntamente	com	a	imagem,	com	o	mesmo	nome,	porém	contendo	o	sufixo	
“stat”	ao	final	do	nome	do	arquivo.	Os	resultados	gerados	pela	segmentação	MSPA	da	ima-
gem da UAP1214 são apresentados na Figura 17. No primeiro exemplo tem-se a frequência 
das classes MSPA na imagem (a) e no segundo (b) a frequência das classes com a divisão da 
área de habitat interior em três subclasses, de acordo com seu tamanho, pequeno (s), médio 
(m) e grande (l).

 
Figura 16. Resultados obtidos pela segmentação MSPA da área de foreground (“Floresta Natural”, “Outras Terras com 
Vegetação Lenhosa” e “Árvores Fora da Floresta”) da UAP 1214 com a subdivisão das áreas Core em classes de tama-
nho, utilizando-se os limiares 1.000 e 4.600 pixels.
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e. Com os resultados da segmentação MSPA armazenados no arquivo de texto, podem ser ge-
rados	gráficos	que	ilustram	a	frequência	das	classes	na	UAP	em	questão,	da	mesma	maneira	
como executado para o mapa de uso e cobertura da terra. Como exemplo, foram gerados 
gráficos	que	ilustram	a	frequência	simples	das	classes	MSPA	na	UAP1214	(Figura	18 (a)) e 
com a subdivisão da classe Core (habitat interior) em classes de tamanho pequeno (p), médio 
(m) e grande (g) de acordo com os limiares anteriormente citados (Figura 18 (b)).

Figura 17. Resultados gerados pela segmentação MSPA da imagem da UAP1214. No primeiro exemplo tem-se a 
frequência das classes MSPA na imagem (a) e no segundo (b) a frequência das classes com a divisão da classe Core em 
três subclasses, de acordo com seu tamanho: pequeno (s), médio (m) e grande (l).

 

Figura 18.	Gráficos	ilustrando	a	frequência	das	classes	MSPA	na	UAP1214,	de	acordo	com	os	resultados	armazenados	
no arquivo de texto (a), incluindo a subdivisão da classe Core (habitat interior) em subclasses de tamanho (pequeno (p), 
médio (m) e grande (g)) (b).
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1.2.3.1 Índices de padrões morfológicos do hábitat

Associados à análise dos padrões morfológicos do habitat da UAP, são calculados quatro índices 
adimensionais, expressos em percentagem, que variam de 0% a 100%:

1. Habitat interior: são as áreas pertencentes às classes de uso e cobertura da terra natu-
rais, com cobertura arbórea e/ou arbustiva (contempladas pelas classes: “Floresta Natural”, 
“Outras Terras com Vegetação Lenhosa” e “Outras Terras com Árvores”), localizadas além 
da distância de 30 metros de borda de outras classes não naturais. Corresponde à classe de 
habitat interior per se na análise MSPA.

2. Ilha de vegetação: são áreas de vegetação natural potencialmente vulneráveis a desapare-
cer	devido	à	sua	forma	e	tamanho	(geralmente	pequenas	e/ou	alongadas,	finas	e	isoladas,	
como é o caso da classe “Outras Terras com Árvores”). Dependendo do contexto da paisagem 
em que se encontram, podem servir como as chamadas stepping stones1 para a polinização 
e dispersão de espécies entre as áreas centrais dos fragmentos. Corresponde à classe islet, 
na análise MSPA.

3. Borda: são as áreas mais vulneráveis à penetração de espécies invasoras e contemplam ca-
racterísticas de borda que, por sua vez, podem afetar as áreas de habitat interior. Corresponde 
ao agrupamento das classes perforation e edge (borda de clareira e bordas) da análise MSPA.

4. Conectores	e	ramificações: áreas que representam conexões estruturais entre as partes in-
ternas de um fragmento e que podem atuar como corredores de biodiversidade. Corresponde 
ao agrupamento das classes loop (alças,	pontes	e	ramificações).

No caso da UAP1214, por exemplo, a proporção de habitat interior é igual a 77,92% da área total 
de foreground da UAP, correspondendo a 51,23% da área total da UAP. Os restantes 0,39% da 
área total da UAP são compostos por ilhas de vegetação, 10,13% por áreas de borda e 4,00% por 
conectores	e	ramificações.

1.3 Modelo de mosaico da paisagem

A	partir	do	mapa	de	uso	e	cobertura	da	terra,	obtido	pela	segmentação	e	classificação	das	imagens,	
deve	ser	realizada	uma	classificação	denominada	Mosaico	da	Paisagem	(Landscape Mosaic - LM) 
no aplicativo GuidosToolbox (Vogt, 2016b). As classes do mapa de uso e cobertura da terra são 
generalizadas de acordo com sua aproximação a ambientes naturais ou seminaturais, áreas de 
cultivo agrícola e áreas urbanizadas, para a elaboração do mapa de mosaicos da paisagem. Este 
indicador	classifica	cada	pixel	do	mapa	de	acordo	com	a	composição	dos	tipos	de	uso	e	cobertura	
em	uma	área	de	vizinhança	pré-definida	ao	seu	redor,	gerando	um	mapa	de	mosaicos	da	paisagem.	
De acordo com o percentual de cada tipo de uso e cobertura da terra, é atribuída ao pixel central de 
uma	janela	móvel	uma	das	19	classes	de	mosaico	possíveis,	contidas	em	um	esquema	de	classifi-
cação tripolar (Figura 19). 

Nos três eixos do triângulo mostrado na Figura 19 estão as proporções dos tipos genéricos de uso 
e	cobertura	da	terra:	agrícola,	urbano	e	natural.	Os	valores	limites	para	definir	o	mosaico	da	paisa-
gem são: ausência (0%), presença substancial (10%), dominância (60%) e exclusividade (100%) de 

1 Em português, “pontos de ligação” ou “trampolins ecológicos” correspondem a pequenas áreas de habitat dispersas pela matriz que podem, para algumas 
espécies,	facilitar	os	fluxos	entre	manchas	(Metzger,	2001).
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cada	um	dos	três	tipos.	Limiares	de	classificação	são,	geralmente,	arbitrários,	mas	os	valores	de-
finidos	são	razoáveis	no	que	diz	respeito	à	estratificação	da	paisagem	para	análises	comparativas	
de habitats em zonas de interferência antrópica (Riitters et al., 2009).

O mapa de mosaicos da paisagem auxilia na visualização das “zonas de interface” (como por exem-
plo,	a	interface	“floresta-área	urbana”)	e	outros	gradientes	espaciais	da	composição	da	cobertura	
em uma região. O objetivo geral dessa abordagem é gerar informações sobre os riscos de isola-
mento de habitats e a intensidade dos efeitos de borda naquele determinado local, devido a ativi-
dades	antrópicas.	Pode-se,	por	exemplo,	estimar	a	proporção	de	florestas	ou	campos	naturais	em	
paisagens com predominância de classes de uso e cobertura naturais, agrícolas ou urbanizadas 
(Riitters et al., 2009). 

A Tabela 6	apresenta	o	nome	das	classes,	a	codificação	em	valores	de	bytes, a tonalidade de cores 
e	os	valores	no	modelo	RGB	adotados	para	as	19	classes	de	mosaico	da	paisagem	para	a	classifi-
cação resultante dessa análise.

Figura 19.	Triângulo	para	classificação	tripolar	do	Mosaico	da	Paisagem,	contendo	19	classes	atribuídas	de	acordo	com	
a proporção de tipos de uso e cobertura que mais se aproximam das categorias “natural”, “agrícola” e “urbano”.
Fonte: Adaptado de Riitters et al. (2009).
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As classes do mosaico são denominadas de acordo com as seguintes regras (Riitters et al., 2009):

•	Letras minúsculas (a, u, n) aparecem no nome da classe se o tipo de cobertura correspondente 
(agrícola, urbano, natural, respectivamente) representar, no mínimo 10%, mas menos que 60% 
da paisagem.

Tabela 6. Nomes, códigos de cores, e valores dos pixels (em bytes) para as classes de padrões resultantes da análise LM.

Nome da classe Valor (byte) R G B Cor

Missing 0 255 255 255

A 1 0 0 255

U 2 255 0 0

N 3 0 255 0

Au 4 128 0 255

An 5 0 128 255

Un 6 255 128 0

Ua 7 255 0 128

Na 8 0 255 128

Nu 9 128 255 0

Aun 10 128 128 255

Uan 11 255 128 128

Nau 12 128 255 128

au 13 128 0 128

an 14 0 128 128

un 15 128 128 0

aun 16 128 128 128

NN 17 0 191 0

AA 18 0 0 191

UU 19 191 0 0
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•	Letras maiúsculas (A, U, N) aparecem no nome da classe se o tipo de cobertura corresponden-
te (agrícola, urbano, natural, respectivamente) representar no mínimo 60%, mas menos que 
100% da paisagem.

•	A letra não irá aparecer se o tipo de cobertura compreender menos que 10% da paisagem.

•	Os nomes das classes AA, UU e NN indicam paisagens que contêm exatamente 100% do tipo 
de cobertura correspondente.

•	Pode-se, ainda, agregar as 19 classes de mosaico em quatro classes de contexto da paisagem 
que	identificam	regiões	dominadas,	ou	seja,	circundadas	por,	no	mínimo,	60%	de	um	dos	três	
tipos genéricos de cobertura e também regiões não dominadas por nenhum tipo de cobertura, 
denominadas de paisagens mistas.

1.3.1 Preparação dos dados para a análise do mosaico da paisagem 

Para a utilização das ferramentas contidas no aplicativo GuidosToolbox é necessário preparar o 
mapa de uso e cobertura da terra, da mesma maneira como executado para a MSPA, de acordo 
com as premissas estabelecidas pelo desenvolvedor para essa análise. Os dados de entrada de-
vem estar em formato raster (grid) do tipo byte (8-bit) e devem conter, no máximo, quatro classes 
com os correspondentes valores em bytes: 1 - Agrícola; 2 - Natural; 3 - Urbano e uma classe opcio-
nal para dados ausentes (missing data) ou corpos d’água, com valor igual a “0”.

Assim,	a	codificação	da	imagem	deve	seguir	o	seguinte	padrão:	à	classe	de	cobertura	“Agricultura	
e Pastagem” deve ser atribuído o valor de pixel igual a “1”, enquanto às classes “Floresta Natural”, 
“Outras Terras com Vegetação Lenhosa”, “Outras Terras com Árvores”, “Floresta Plantada”, 
“Gramíneas	e	Herbáceas”	e	“Dunas	e	Afloramentos	Rochosos”	deve	ser	atribuído	o	valor	de	pixel 
igual	a	“2”.	Para	as	demais	classes	de	uso	e	cobertura	(“Solo	exposto”	e	“Influência	Urbana”),	com	
exceção das grandes massas d’água, deve ser atribuído o valor igual a “3”. Em locais de ocorrência 
das grandes massas d’água ou de dados ausentes devem ser atribuídos valores iguais a “0”, con-
forme demonstrado na Tabela 7.

Tabela 7.	Codificação	das	classes	de	uso	e	cobertura	da	terra	nas	UAPs	de	acordo	com	as	classes	para	a	análise	do	
mosaico da paisagem.

Classes de uso e cobertura da terra Classes do mosaico da 
paisagem Valor (byte) Obrigatoriedade

Regiões onde não há disponibilidade de dados 
ou corpos d’água

Dados ausentes  
(missing data)

0 Opcional

“Agricultura e Pastagem” Agrícola 1 Obrigatório
“Floresta Natural”, “Outras Terras com 
Vegetação Lenhosa”, “Outras Terras com 
Árvores, “Gramíneas e Herbáceas”, “Floresta 
Plantada”	e	“Dunas	e	Afloramentos	Rochosos”

Natural/Seminatural 2 Obrigatório

Áreas com interferência antrópica (“Solo 
exposto”	e	“Influência	Urbana”)

 Urbano 3 Obrigatório

Para	 a	 codificação	 da	 imagem	 foi	 utilizado	 o	mesmo	 arquivo	 vetorial	 codificado	 para	 a	 análise	
MSPA, oriundo da união dos arquivos correspondentes ao mapa de uso e cobertura da terra e o ar-
quivo contendo os polígonos de massa d’água referentes à área da UAP em questão, como segue:
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a. Abrir no ArcMap o arquivo vetorial gerado pela união das camadas supracitadas.

b.	 Para	a	codificação	das	classes	de	uso	e	cobertura	da	terra,	de	acordo	com	as	premissas	es-
tabelecidas para utilização no aplicativo GuidosToolbox, é necessária a criação de um novo 
atributo, que deve conter os códigos estabelecidos na Tabela 7 para cada polígono do mapa. 
Sendo assim, deve-se, então, abrir a tabela de atributos e adicionar um novo campo do tipo 
“Short Integer” (uma vez que apenas valores entre 0 e 3 serão utilizados).

c. Seguindo as mesmas premissas dos itens “e”, “f”, “g” e “h” do tópico “1.2.1 Preparação dos 
dados para a análise MSPA ”,	deve-se	efetuar	a	seleção	e	codificação	das	classes.

d.	 Após	a	codificação	do	arquivo	vetorial	do	mapa	de	uso	e	cobertura	da	terra	deve	ser	gerado	
um arquivo em formato raster contendo, em cada célula, o valor a ser utilizado nas análises 
do GuidosToolbox. Para tanto, deve-se proceder da mesma maneira conforme descrito nos 
itens “i” e “j” do tópico “1.2.1 Preparação dos dados para a análise MSPA ”.

1.3.2 Elaboração do mosaico da paisagem

Com o arquivo em formato raster preparado para uso no aplicativo GuidosToolbox, pode-se dar iní-
cio	ao	processamento	do	mapa	de	uso	e	cobertura	da	terra	codificado	para	a	geração	do	mosaico	
da paisagem:

a. Abrir a imagem utilizando o menu “File > Read Image > GeoTiff”.

b.	 A	imagem	aberta	deve	conter	apenas	os	quatro	valores	utilizados	na	codificação	das	classes	
realizada anteriormente, variando de 0 a 3 em números inteiros. A área ocupada pela classe 
“Agricultura e Pastagem” deve apresentar valor igual a “1”, enquanto as classes “Floresta 
Natural”, “Outras Terras com Vegetação Lenhosa”, “Outras Terras com Árvores”, “Floresta 
Plantada”,	“Gramíneas	e	Herbáceas”	e	“Dunas	e	Afloramentos	Rochosos”	devem	apresentar	
valor	igual	a	“2”.	Por	sua	vez	as	áreas	pertencentes	às	classes	“Solo	exposto”	e	“Influência	
Urbana” devem apresentar valor igual a “3” e as demais classes (“Superfície com água” e 
“Área não Observada”) igual a “0”.

c. Para dar início ao processamento do mosaico da paisagem deve-se selecionar, a partir do 
menu “Image Analysis”, a opção “Pattern” e em seguida as opções “Moving Window” e “LM”, 
respectivamente (“Image Analisys > Pattern > Moving Window > LM”), conforme apresentado 
na Figura 20.

 
Figura 20. Parte da janela principal do GuidosToolbox, exibindo a sequência de menus necessária para a ativação do 
cálculo de LM.
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Figura 21. Janela do GuidosToolbox para a seleção da dimensão da janela móvel que será adotada para a convolução 
da imagem.

d. Após selecionada a opção LM do menu Image Analysis uma janela será aberta onde o usu-
ário	deverá	especificar	a	dimensão	da	janela	móvel	(Moving Window) que será utilizada para 
a	análise	da	imagem.	A	janela	de	tamanho	definido	pelo	usuário	é	sobreposta	a	cada	pixel 
da imagem de entrada. A métrica selecionada é, então, calculada para a área da janela, e o 
resultado é atribuído ao pixel central na imagem de saída. Assim, no caso das UAPs deve-se 
estabelecer a dimensão da janela igual a 13 colunas por 13 linhas, conforme demonstrado na 
Figura 21, e clicar em Accept.

d)  

Usando uma janela de 13 x 13 pixels, a vizinhança imediata ao pixel central equivale a 0,42 ha (1 pi-
xel = 5 m; 13 pixels = 65 m; 13 x 13 pixels = 4.225 m2 ou 0,42 ha). Esse tamanho de janela também 
determina que a distância de penetração dos efeitos de áreas não-naturais ou seminaturais, quan-
do	presentes,	seja	de,	no	máximo,	50	m	para	dentro	de	um	fragmento	florestal	(Estreguil;	Mouton,	
2009). Esse valor é obtido por meio de um cálculo de vizinhança que considera a direção diagonal 
da janela móvel. A diagonal de cada pixel é calculada pela diagonal d do quadrado (d = l√2), onde l é 
o tamanho do pixel (5 m). A diagonal da janela móvel contempla sete pixels e sua medida, portanto, 
é igual a sete vezes a diagonal d de cada pixel (7 x 7,07) ou, aproximadamente, 50 m.

1.3.3 Resultados da análise do mosaico da paisagem

Após o processamento do mosaico da paisagem de acordo com o anteriormente exposto, os re-
sultados obtidos podem ser analisados. O resultado da convolução da imagem é apresentado na 
interface	gráfica	do	programa.	Como	exemplo,	apresenta-se	o	mosaico	da	paisagem	obtido	para	
a UAP1214, juntamente com observações a respeito da interpretação e análise dos resultados, a 
seguir:

a. Assim que o processamento é concluído, a imagem resultante é apresentada na interface 
gráfica	do	programa,	de	acordo	com	as	classes	de mosaico da paisagem e legenda anterior-
mente indicados (Figura 22),	podendo-se	armazenar	a	imagem	resultante	em	formato	GeoTiff	
utilizando o menu “File > Save Image > GeoTiff” na janela principal do programa.

b. Com a imagem raster em	 formato	 GeoTiff	 pode	 ser	 gerado	 um	 histograma	 que	 ilustra	 a	
frequência das classes de mosaico da paisagem, com auxílio do ArcMap. Como exemplo, 
gerou-se	um	gráfico	que	ilustra	a	frequência	simples	das	classes	de	mosaico	da	paisagem	na	
UAP1214 (Figura 23).

c.	 Para	isso,	deve-se	primeiramente	abrir	o	arquivo	GeoTiff	resultante	da	análise	do	mosaico	da	
paisagem gerado pelo GuidosToolbox, no ArcMap.
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d. Para habilitar a ferramenta de geração do histograma deve-se clicar com o botão direito do 
mouse em qualquer parte da janela principal do aplicativo e marcar a opção “Spatial Analyst”. 
Selecionar o arquivo raster resultante da análise do mosaico da paisagem e clicar na opção 
“Create histogram”; conforme ilustrado na Figura 24 (a).

Figura 23.	Gráfico	ilustrando	a	frequência	das	classes	de	mosaico	da	paisagem	na	UAP1214,	de	acordo	com	os	resulta-
dos obtidos a partir da imagem gerada pelo GuidosToolbox.

 
Figura 22. Resultado do Mosaico da Paisagem para a UAP 1214.
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e. Clicar com o botão direito do mouse no histograma gerado e selecionar a opção “Export” 
(Figura 24 (b)). Em seguida uma nova janela será aberta, onde deve-se selecionar a opção de 
formato de arquivo Excel, na aba “Data”, e os dados poderão ser salvos clicando-se no botão 
“Save...” (Figura 24	(c)),	indicando-se	o	local	de	armazenamento	e	definindo-se	o	nome	do	
arquivo a ser gerado.

A agregação das 19 classes do mosaico da paisagem ilustradas na Figura 19 em quatro classes de 
contexto	da	paisagem,	como	na	Figura	25,	item	(a),	permite	identificar	se	a	paisagem	da	UAP	em	
questão é dominada por um dos três tipos de cobertura generalizados, ou se não há dominância de 
nenhum	nas	classes	gerais	(natural,	agrícola	ou	urbano),	compondo	uma	paisagem	de	influência	
mista. No caso da UAP1214, por exemplo, considerando toda a área da UAP analisada, exceto 
missing data (corpos d’água ou nuvens), aproximadamente 75% da área mapeada está contida em 
um contexto da paisagem com dominância de cobertura natural/seminatural (Figura 26).

O modelo de Mosaico da Paisagem utilizado pelo software GuidosToolbox é	implementado	classifi-
cando a paisagem em torno de cada pixel, e mapeando o mosaico da paisagem em nível de pixel, 
o	que	possibilita	subsequentes	sobreposições	geográficas	para	extrair	informações	estatísticas	es-
pecíficas	para	classes	de	interesse	(Riitters	et	al.,	2009).	No	caso	da	componente	de	paisagem	do	
IFN-BR, a classe focal de interesse é composta pela área de cobertura arbórea/arbustiva natural, 
que contempla as classes de uso e cobertura da terra “Floresta Natural” (1), “Outras terras com 
Vegetação Lenhosa” (2) e “Outras terras com Árvores” (3).

Considerando que as classes de maior interesse do IFN-BR são as que contém cobertura arbórea/
arbustiva,	utilizou-se	uma	estratificação	temática,	obtida	pelo	cruzamento	das	camadas	de	informa-
ção do mosaico da paisagem e de uso e cobertura da terra, visando extrair os valores dos pixels do 
mosaico da paisagem correspondentes às classes de interesse. Dessa maneira, é possível avaliar 
o percentual da classe de interesse composta por paisagens dominadas por uso e cobertura do tipo 

 

(a)

  

(b)
(c)

Figura 24. Janelas do ArcMap utilizadas na geração do histograma da imagem raster resultante da análise do mosaico da 
paisagem, com auxílio da ferramenta “Spatial Analyst” (a) e a posterior exportação dos dados (b) em formato de planilha 
Excel (c).
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Figura 25. As 19 classes do mosaico foram condensadas em quatro classes, para realçar o contexto da paisagem, no 
item (a); as 19 classes do mosaico da paisagem foram condensadas em seis classes para realçar mosaicos de paisagem 
inseridos em um contexto natural, no item (b).
Fonte: Riitters et al. (2009).

Figura 26.	Gráfico	 de	 distribuição	 da	 proporção	 de	 classes	 do	 contexto	 do	mosaico	 da	 paisagem	para	 a	UAP1214,	
identificando	que	essa	UAP	está	inserida	em	uma	paisagem	de	classes	predominantemente	naturais.
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natural, agrícola ou urbano e também quanto da classe focal está inserida em paisagens onde não 
há	predominância	de	nenhum	uso	específico	(conforme	ilustrado	na	Figura	25,	item	(a)).	Da	mesma	
forma, pode-se avaliar a proporção da classe de interesse inserida em um contexto onde predomi-
nam apenas as classes naturais do mosaico (Figura 25, item (b)) (Riitters et al., 2009).

Para realizar essa intersecção deve-se proceder da seguinte maneira:

a. No ArcMap, criar um novo projeto contendo as camadas referentes ao mapa de uso e cobertu-
ra da terra (formato shapefile) e mapa do mosaico da paisagem, gerado por meio do software 
GuidosToolbox (formato raster).
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b. Utilizando a ferramenta “Raster to Polygon” (“ArcToolBox > Conversion Tools > From Raster 
> Raster to Polygon”), converter o arquivo raster para o formato shapefile, desmarcando a 
opção “Simplify polygons (optional)”.

c. Por meio da ferramenta “Selection by Attribute” (localizada na aba “Selection” do menu prin-
cipal do programa), selecionar no arquivo shapefile correspondente ao mapa de uso e co-
bertura da terra apenas classes correspondentes à cobertura arbórea/arbustiva: 1 (Floresta 
Natural), 2 (Outras terras com Vegetação Lenhosa) e 3 (Outras terras com Árvores): “LULC” 
= 1 OR “LULC” = 2 OR “LULC” = 3.

d. Após efetuada a seleção, aplicar a ferramenta “Intersect” (“ArcToolBox > Analysis Tools > 
Overlay > Intersect”), utilizando como inputs os arquivos shapefile correspondentes ao mapa 
de uso e cobertura da terra (com as classes de interesse selecionadas) e o mapa do mosaico 
da paisagem.

e. Na tabela de atributos do arquivo gerado após a utilização da ferramenta “Intersect”, criar um 
novo campo (AREA_ha) e calcular a área de cada polígono em hectares.

f. Como “Input Table” para a ferramenta “Summary Statistics” (“ArcToolBox > Analysis Tools 
> Statistics > Summary Statistics”), utilizar a tabela de atributos com as áreas calculadas. 
Escolher o campo “AREA_ha” para “Field”, “SUM” para “Statistic Type” e o campo “GRIDCODE” 
para “Case field (optional)”.

g. Esse procedimento irá gerar uma tabela contendo os dados sumarizados para as áreas de 
cada classe do mosaico da paisagem contida dentro da área de interesse.

h. Usando qualquer aplicativo de planilha eletrônica é possível calcular a proporção (percentual) 
da área ocupada por cada classe do mosaico da paisagem em relação à área de cobertura 
arbórea/arbustiva da UAP em questão.

Para a UAP1214, os valores obtidos, apresentados na Figura 27, indicam que mais de 80% de toda 
a área de cobertura arbórea/arbustiva natural da UAP possui em sua vizinhança próxima (0,42 hec-
tares) paisagens onde não há evidência de uma zona de interface antrópica (classe NN do mosaico 
da paisagem).

Figura 27. Percentual de ocupação das classes do mosaico da paisagem predominantemente naturais, para a área de 
cobertura arbórea/arbustiva natural na UAP1214.

 
Classes do Mosaico da Paisagem

%
 d

e 
ár

ea
 to

ta
l d

a 
co

be
rtu

ra
 

ar
bó

re
a/

ar
bu

st
iv

a



47Manual de Análise de Paisagem: volume 3: Procedimentos para a geração de Índices Espaciais das Unidades Amostrais de Paisagem

1.3.3.1 Índices de mosaico da paisagem

Os índices de mosaico da paisagem são calculados pela soma dos percentuais de ocupação das 
classes de mosaico da paisagem no que se refere à cobertura arbórea/arbustiva natural e agrupa-
dos em três categorias adaptadas daquelas originalmente propostas por Estreguil e Mouton (2009) 
e Estreguil et al. (2014), expressos em valores percentuais, adimensionais, variando de 0 a 100, 
conforme exposto na sequência:

•	Padrão	de	paisagem	florestal	natural (Natural forest landscape pattern): índice originado da 
soma	dos	percentuais	de	NN	e	N.	Representa	florestas	com	no	mínimo	80%	de	cobertura	natu-
ral/seminatural e menos de 10% de áreas urbanizadas ou com agricultura e pastagem em seu 
entorno;	considera-se	para	os	habitats	florestais	e	espécies	contidos	nesse	tipo	de	paisagem	
nenhum efeito de borda derivado de terras agrícolas ou áreas antrópicas, pois as zonas de 
interface	da	floresta	com	outros	tipos	de	uso	são	naturais.

•	Padrão	de	paisagem	florestal	mista (Mixed forest landscape pattern): índice originado da 
soma	dos	percentuais	de	Nu,	Nau	e	Na.	Representa	florestas	com	variação	de	89%	a	60%	de	
cobertura	florestal	natural/seminatural,	e	mais	de	10%	de	áreas	antrópicas	ou	terras	agrícolas	
em	seu	entorno;	habitats	florestais	e	espécies	contidas	nesse	padrão	misto	de	paisagem	(zo-
nas de interface mista) estão potencialmente sofrendo efeitos de borda pela presença de áreas 
agrícolas ou urbanizadas.

•	Paisagem	florestal	com	algum	elemento	natural	(“Some natural” forest landscape): índice 
originado da soma dos percentuais das demais classes (AA, A, An, Aun, Au, UU, U, Un, Uan, 
Ua,	aun,	un,	an	e	au).	Indica	habitats	florestais	e	espécies	inseridas	em	uma	paisagem	domi-
nantemente	não	florestal,	e	que,	muito	provavelmente,	encontram-se	sob	o	efeito	de	borda	
dominante de terras agrícolas e/ou urbanizadas.

Para a UAP1214, utilizada como exemplo, os índices de mosaico na paisagem apresentaram os 
valores descritos na Tabela 8:

Tabela 8. Índices de Mosaico da Paisagem da UAP 1214.

Mosaicos Predominantes na cobertura arbórea/
arbustiva da Paisagem Classes de LM Índices de Mosaico na 

Paisagem (%)
Padrão	de	paisagem	florestal	natural NN e N 87,78
Padrão	de	paisagem	florestal	mista Nu, Nau e Na 9,17
Paisagem	florestal	com	algum	elemento	natural AA, A, An, Aun, Au, UU, U, Un, Uan, 

Ua, aun, un, an e au
3,05

1.4 Modelo de interface de bordas

A importância da análise de Interface de Bordas reside no fato de que a fragmentação está relacio-
nada	à	mudança	do	uso	e	cobertura	da	terra	de	áreas	adjacentes	a	fragmentos	florestais,	de	forma	
que esse indicador permite avaliar a susceptibilidade a que estão submetidas as bordas dos frag-
mentos, quanto à pressão antrópica imposta por outros tipos de uso e cobertura. A permeabilidade 
das zonas de interface para a dispersão de espécies depende da similaridade dos tipos de habitat 
adjacentes e é provavelmente maior no caso de interfaces de bordas naturais. Assim, índices de 
proporção	de	bordas,	conectores	e	ramificações	e	ilhas	de	vegetação	com	interfaces	naturais	mais	
altos, representam situações mais favoráveis.
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1.4.1 Aplicação da abordagem do modelo de interface de bordas

O modelo de interface de bordas é derivado da integração do mosaico da paisagem e do modelo de 
MSPA (Estreguil et al., 2014), sendo caracterizado de acordo com a similaridade de habitats adja-
centes (se a interface entre as bordas da cobertura arbórea/arbustiva ocorre com áreas naturais e 
seminaturais,	ou	mais	antrópicas	e	artificiais).	Sendo	assim,	para	elaboração	do	mapa	de	Interface	
de Bordas, deve-se sobrepor as imagens resultantes das análises MSPA e do mosaico da paisagem 
(LM)	e	utilizar	uma	nova	codificação	para	as	classes,	conforme	descrito	na	sequência:

a. Abrir os arquivos do tipo raster, em formato GeoTiff, gerados pelo GuidosToolbox para o 
MSPA e o LM, no programa ArcMap e converter ambos para formato de arquivo vetorial, utili-
zando a ferramenta “Raster to polygon”, sem a suavização de linhas.

b. Executar a união dos arquivos vetoriais do MSPA e do LM utilizando a ferramenta “Union”, 
gerando um arquivo vetorial contendo tanto os códigos das classes referentes à segmentação 
MSPA quanto aquelas relativas às classes de mosaico da paisagem (LM), em sua tabela de 
atributos.

c. Criar três novos campos, do tipo “Short integer”, na tabela de atributos do arquivo originado 
pelo processo de união: “MSPA_Code”, “LM_Code” e “EDGE_Code”. Em seguida, deve-se 
identificar	na	tabela	de	atributos	qual	coluna	corresponde	aos	códigos	da	segmentação	MSPA	
(variam de 0 a 169) e do LM (variam de 0 a 19) e copiar para os campos correspondentes 
recém-criados.

d. Utilizando a ferramenta “Selection by Attributes” selecionar os itens de acordo com o exposto 
na Tabela 9. Demonstra-se na Figura 28 (a) como realizar a seleção dos itens corresponden-9. Demonstra-se na Figura 28 (a) como realizar a seleção dos itens corresponden-. Demonstra-se na Figura 28 (a) como realizar a seleção dos itens corresponden-
tes à classe “Core”	na	codificação	para	o	Modelo	de	Interface	de	Bordas.	Por	meio	da	ferra-
menta deve-se selecionar os polígonos que possuem classe de MSPA igual a “Core” (código 
116, 16, 117, 17, 118 ou 18) nas mesmas áreas em que as classes da análise LM são iguais 
a “N”, “Na”, “Nd” ou “NN” (códigos iguais a 3, 8, 9 ou 17).

Tabela 9.	Codificação	das	classes	MSPA	e	LM	nas	UAPs	de	acordo	com	as	classes	para	a	análise	de	Interface	de	Bordas.

Valor	de	codificação	do	
modelo de interface de 

bordas
Classe de Interface de Bordas Classe MSPA 

Classe de 
mosaico da 
paisagem 

1 Habitat interior (Core) 116/16; 117/17; 118/18 3; 8; 9; 17
2 Cobertura	não	florestal	(Background) 100; 0 0 a 19
3 Borda com interface “natural” (BONN) 105/5; 103/3 17
4 Borda	com	interface	“artificial”	(BOo) 105/5; 103/3 0 a 16; 18 a 19
5 Conectores	e	ramificações	com	

interface “natural” (CONN)
165/65; 167/67; 169/69; 
133/33; 135/35; 137/37; 101/1

17

6 Conectores	e	ramificações	com	
interface	“artificial”	(COo)

165/65; 167/67; 169/69; 
133/33; 135/35; 137/37; 101/1

0 a 16; 18 a 19

7 Ilhas de vegetação com interface 
“natural” (ISNN)

109/9 17

8 Ilhas de vegetação com interface 
“artificial”	(ISo)

109/9 0 a 16; 18 a 19

9 Dados ausentes 129 -
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e. Preencher na tabela de atributos a coluna “EDGE_Code” com o código correspondente à se-
leção realizada – no caso do exemplo refere-se ao código “1”, como exibido na Figura 28 (b).

f.	 Realizar	a	seleção	e	a	codificação	da	tabela	de	atributos	para	todos	os	valores	das	diferentes	
classes do modelo de Interface de Bordas, seguindo a mesma lógica da Figura 28.

g. Para elaboração do mapa de Interface de Bordas e diferenciação das classes deve-se utilizar 
a escala de cores exposta na Tabela 10. Abrir a janela de propriedades da camada vetorial 
(“Layer Properties”) com um duplo clique sobre ela no menu “Table of Contents” do ArcMap 
e selecionar a aba “Symbology”	para	definição	da	legenda,	ilustrada	na	Figura	29	(a).	Na	re-
ferida aba selecionar a opção de legenda por “Categories” utilizando “Unique values” de um 
campo. Para o “Value Field”	selecionar	o	campo	contendo	a	codificação	para	o	Modelo	de	
Interface de Bordas – no caso do exemplo seria o campo “EDGE_Code”; clicar em “Add All 
Values”. Serão atribuídas diferentes cores para cada classe.

h. Para a edição das cores das classes de acordo com a legenda proposta, deve-se dar um du-
plo clique na cor/classe que se deseja alterar. A janela “Symbol Selector” será aberta. Clicar 
na opção “Fill Color” e então em “More Colors...” (Figura 29 (b)). A janela “Color Selector” se 
abre	(Figura	29	(c)),	permitindo	a	seleção	dos	valores	no	modelo	RGB	de	cores	e	a	codifica-
ção de cada classe conforme apresentado na Tabela 10. Deve-se manter o valor de “Outline 
Color” igual a zero, para todas as classes.

i.	 Definida	a	codificação	correta	para	cada	classe	da	legenda,	aplicar	as	alterações	ao	mapa	
clicando-se em “OK”, na janela “Layer Properties”. Na janela principal do ArcMap será apre-
sentado	o	mapa	de	acordo	com	a	legenda	definida	para	o	modelo	de	Interface	de	Bordas.

Figura 28. Janelas do ArcMap mostrando o processo de (a) seleção por atributo das áreas Core para o modelo de Inter-
face de Bordas, utilizando a associação dos códigos oriundos do MSPA e do LM; bem como (b) a janela da calculadora 
de	campo	para	o	preenchimento	da	coluna	criada	para	a	nova	codificação.

 

e)  

 
Figura 28.  Janelas do ArcMap mostrando o processo de (a) seleção por atributo das áreas Core para o modelo de 

Interface de Bordas, utilizando a associação dos códigos oriundos do MSPA e do LM; bem como (b) a 
janela da calculadora de campo para o preenchimento da coluna criada para a nova codificação; 
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Tabela 10.	Codifi	cação	da	legenda,	valores	no	modelo	RGB	e	tonalidade	de	cores	das	classes	para	elaboração	do	mapa	
de Interface de Bordas.

Valor de 
codifi	cação Classe de Interface de Bordas R G B Cor 

1 Habitat interior (Core) 225 225 225

2 Cobertura	não	fl	orestal	(Background) 255 255 255

3 Borda com interface “natural” (BONN) 115 178 225

4 Borda	com	interface	“artifi	cial”	(BOo) 190 210 255

5 Conectores	e	ramifi	cações	com	interface	“natural”	(CONN) 223 115 255

6 Conectores	e	ramifi	cações	com	interface	“artifi	cial”	(COo) 232 190 255

7 Ilhas de vegetação com interface “natural” (ISNN) 255 211 127

8 Ilhas	de	vegetação	com	interface	“artifi	cial”	(ISo) 255 235 175

9 Dados ausentes 178 178 178
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Figura 29. Janelas do ArcMap 
mostrando o processo de criação da 
legenda para o Modelo de Interface 
de Bordas: (a) categorias da legenda 
a partir de valores únicos baseados no 
campo “EDGE_Code”; (b) seleção da 
cor	 de	 preenchimento	 e	 (c)	 definição	
dos valores no modelo RGB de cores.

 

(b)

(a)

 

 

(c)

1.4.2 Resultados do modelo de interface de bordas

Após	definida	e	aplicada	a	correta	legenda	do	modelo	de	interface	de	bordas,	conforme	definido	
no item anterior, obtém-se como resultado o Mapa de Interface de Bordas (Figura 31), podendo-se 
então calcular a área ocupada por cada classe, conforme descrito a seguir:

a. Adicionar à tabela de atributos desta camada vetorial uma nova coluna (“AREA_ha”) do tipo 
Double com precisão (Precision) e escala (Scale) iguais a 20 e 10 unidades, respectivamente. 
Com o botão direito do mouse, clicar na nova coluna criada e utilizar a ferramenta “Calculate 
Geometry...” para calcular a área de cada polígono em hectares, conforme demonstrado na 
Figura 30 (a).
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Figura 31. Resultado do Modelo de Interface de Bordas para a UAP1214. 

Figura 30. Janelas do ArcMap para o cálculo da área dos polígonos em hectares, por meio da ferramenta “Calculate 
geometry” (a), e a sumarização das áreas de cada classe do modelo de Interface de Bordas, por meio da ferramenta 
“Summarize” (b). 

 

 

(b)

(a)
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b. Novamente clicar com o botão direito na coluna correspondente à área em hectares e selecio-
nar a opção “Summarize”. No campo “1. Select a field to sumarize:” escolher a coluna com a 
codificação	para	a	Interface	de	Bordas,	e	no	campo	“2” escolher a opção “Sum” para a coluna 
correspondente às áreas, da mesma maneira como ilustrado na Figura 30 (b). Essa ferramen-
ta irá criar uma nova tabela (em formato dBASE) contendo a soma das áreas para cada uma 
das classes de Interface de Bordas.

c.	 A	partir	destes	dados,	pode	ser	gerada	uma	visualização	gráfica	dos	valores	obtidos.	O	grá-
fico	ilustra	as	proporções,	em	percentual,	da	superfície	ocupada	pelas	diferentes	classes	de	
interface	de	borda.	Como	exemplo,	é	apresentado	o	gráfico	que	ilustra	a	frequência	simples	
das classes de interface de borda na UAP1214 (Figura 32).

Figura 32.	Gráfico	ilustrando	a	frequência	das	classes	de Interface de Bordas na UAP1214, de acordo com os resultados 
obtidos a partir da sumarização das áreas do mapa, onde BO = Bordas, CO = Conectores, IS = Ilhas, NN = interface 
natural.

1.4.2.1 Índices derivados do modelo de interface de bordas

Derivam desta análise seis índices adimensionais, expressos em percentagem e com amplitude de 
zero a 100%:

•	Proporção de bordas com interface natural (BONN).

•	Proporção	de	bordas	com	interface	artificial	(BOO). 

•	Proporção	de	conectores	e	ramificações	com	interface	natural	(CONN).

•	Proporção	de	conectores	e	ramificações	com	interface	artificial	(COO). 

•	Proporção de ilhas de vegetação com interface natural (ISNN).

•	Proporção	de	ilhas	de	vegetação	com	interface	artificial	(ISO).

Como exemplo são apresentados os resultados obtidos para a UAP1214, que possui interfaces pre-
dominantemente	artificiais,	tanto	com	relação	a	suas	bordas	(74,50%),	quanto	conectores	(76,78%)	
e ilhas (84,41%), como se pode analisar na Tabela 11.

 
Classes de Interface de Bordas

Ár
ea

 (%
)
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1.5 Análise de conectividade 

Os resultados da análise MSPA podem ser convertidos em uma “rede” para posterior análise no 
aplicativo Conefor Sensinode (Saura; Torné, 2009), que se baseia na teoria dos grafos. São con-
siderados grafos, nesta abordagem, os conjuntos de nós e conexões de forma que cada conexão 
conecta dois nós. Os nós representam unidades propícias de habitat cercados de áreas inabitáveis, 
enquanto as conexões simbolizam a habilidade potencial da dispersão direta das espécies entre 
dois nós (por meio de um corredor, por exemplo) (Saura; Torné, 2009). No caso da abordagem 
adotada para a análise da conectividade das UAPs, uma “rede” é composta de áreas de habitat 
interior (“nós”) e de pontes (“conexões” entre áreas de habitat interior diferentes), resultantes da 
MSPA, sendo as demais classes MSPA negligenciadas. Um conjunto de nós conectados e suas 
conexões denomina-se “Componente”. No GuidosToolbox estão disponíveis, após a segmentação 
MSPA, algumas ferramentas para a obtenção de informações a respeito das redes de fragmentos 
de vegetação arbórea/arbustiva natural na paisagem, descritos a seguir.

1.5.1 Componentes da rede (NW Components)

Partindo-se	do	resultado	da	segmentação	MSPA	podem	ser	identificados	os	componentes	da	rede,	
compostos apenas pelas classes de habitat interior e pontes (Core e Bridge), utilizando-se o coman-
do Image Analysis > Network >NW Components, como demonstrado na Figura 33. 

Tabela 11. Índices baseados na Interface de Bordas.

Índices baseados na interface de bordas Índices de mosaico na paisagem (%)
BONN 25,50
BOO 74,50
CONN 23,22
COO 76,78
ISNN 15,59
ISO 84,41

 

O	resultado	da	identificação	de	cada	componente	da	paisagem	é	apresentado	na	janela	principal	do	
programa, onde os componentes individuais da rede são exibidos com cores alternadas e podem 
ser	consultados	os	valores	do	identificador	único	de	cada	componente	(ID), bem como sua área 
total (em pixels) e a contribuição de cada conexão à conectividade da paisagem, conforme ilustrado 
pela Figura 34, item 1. Nessa representação, a cor preta é usada para componentes compostos 
apenas por nós, sem conexões.

Figura 33.	Posicionamento	do	botão	de	ativação	que	permite	a	identificação	dos	componentes	da	rede	de	fragmentos	
florestais	na	UAP	(NW Components). 
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O resultado desta operação pode ser armazenado a partir do menu “File > Save Image > GeoTiff”, 
de	forma	que	três	arquivos	são	produzidos:	um	arquivo	de	imagem	contendo	os	gráficos	visualiza-
dos na tela do GuidosToolbox, em formato tif (<name>_nw.tif); um segundo arquivo de imagem com 
os	identificadores	(IDs) dos componentes armazenados nos valores dos pixels, também em formato 
tif (<name>_nw_nwdata.tif); e, o terceiro, um arquivo de texto contendo o número de componentes, 
o ECA total (Equivalent Connected Area) e o ECA relativo (percentual), a área de habitat interior 
(core) e o número de conexões de cada componente, em formato txt (<name>_nw_stat_txt). O ar-
quivo de texto gerado ao salvar a imagem dos componentes da rede da UAP1214 é apresentado 
na Figura 35. Todos os componentes da rede são elencados, juntamente com a área (em pixels) e 
o número de conexões de cada componente.

 
Figura 34. Janela principal do GuidosToolbox mostrando	o	resultado	da	identificação	dos	componentes	que	compõem	o	
foreground da paisagem da UAP1214 (NW Components).

 

Figura 35. Arquivo de saída 
gerado pela operação que 
permite o cálculo dos compo-
nentes da rede, sua área (em 
pixels) e suas respectivas 
conexões, para a UAP1214. 
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Tanto o ECA quanto o ECA_rel descrevem o grau de conectividade da rede na imagem. O ECA é 
medido em unidades de área, (em hectares, ou, no caso genérico, em unidades de pixel), e é cal-
culado a partir da raiz quadrada de PCnum (Equação 1), a conectividade geral da rede. O ECA_rel, 
por sua vez, representa o ECA relativo, ou normalizado, expresso em percentual, com respeito 
ao ECAmax, (Equação 2), quando todos os componentes estão totalmente conectados. O ECA_rel 
também é conhecido como quantidade de habitat acessível (amount of reachable habitat (ARH)) ou 
percentagem de habitat acessível (percentage of reachable habitat (PRH)).

1.5.2 Importância dos nós e conexões 

Após o cálculo dos componentes da paisagem (NW Components), pode ser determinada a impor-
tância das conexões existentes em cada nó, ativando-se o comando Image Analysis > Network > 
Node/Link Importance (Figura 36). Este comando só pode ser ativado após o cálculo dos compo-
nentes, conforme anteriormente demonstrado. 

PCnum = ∑ (node area of componenti )
2

N

i=1
Equação (1)

ECAmax = ∑     (node area of componenti )
N
i=1 Equação (2)

Figura 36. Localização da ferramenta para o cálculo da importância das conexões dos componentes da rede na UAP 
(Node/Link Importance).

Esta opção permite calcular a importância da conectividade de todo e cada nó e toda e cada cone-
xão da rede. O resultado do cálculo da importância das conexões de cada nó (habitat interior) da 
rede	é	apresentado	na	Figura	37,	onde	pode	ser	consultado	o	identificador	de	cada	nó,	sua	conec-
tividade absoluta e relativa, na janela de informações indicada pelo item 1. 

Ao armazenar a imagem resultante por meio do menu File > Save Image > GeoTiff, são gerados e 
armazenados, também, outros três arquivos além da imagem em formato tif (<name>_cs.tif), visu-
alizada na janela principal do GuidosToolbox: um arquivo de imagem, em formato tif, contendo a 
importância da conectividade para cada nó e cada conexão (<name>_cs_conn.tif); outro arquivo de 
imagem	tif,	contendo	identificadores	únicos	para	cada	nó	e	cada	conexão,	onde	os	nós	são	repre-
sentados por valores negativos, para diferenciá-los das conexões (<name>_cs_ids.tif); e um arquivo 
do tipo texto, contendo o número de componentes, nós e conexões da rede, o número de conexões 
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e nós de cada componente, o número total de pixels de cada componente, dos nós e das conexões 
seguidos das informações individuais dos nós e das conexões de cada componente, como o iden-
tificador,	número	de	pixels,	a	diferença	de	probabilidade	de	conectividade	dPC (delta probability of 
connectivity), para cada componente, e a importância de cada conexão (<name>_cs_stat).

Como se pode observar na Figura 38 (a), que apresenta os resultados obtidos para o cálculo da 
importância dos nós e conexões da rede da UAP1214, o componente número 1 é formado por 29 
conexões (links) e 27 nós (nodes), e tem área igual a 370.074 pixels (ou 925,185 hectares, já que a 
área do pixel das imagens RE no terreno é igual a 25 m2).	Na	mesma	figura,	item	(b),	pode-se	ainda	
observar que o componente 4 representa um nó que não possui conexões com outros componen-
tes, e tem área igual a 354 pixels. Ainda na Figura 38 (c) são apresentados os resultados obtidos 
para o componente número 36, a listagem de todos os nós (com o sinal negativo antecedendo o 
identificador	de	cada	nó)	e	as	conexões	de	cada	componente.	Estas	informações	estão	presentes	
no arquivo para todos os 128 componentes da rede. 

A partir desses dados é possível gerar um mapa contendo os nós e conexões presentes em cada 
UAP, e sua respectiva graduação em termos de importância na paisagem, de acordo com o índice 
denominado diferença de probabilidade da conectividade dPC (delta probability of connectivity). Os 
valores de dPC para cada nó e conexão são calculados com base no decréscimo de conectividade 
que	seria	verificado	para	uma	determinada	paisagem	com	a	remoção	do	referido	nó	ou	conexão.	

Assim, a partir do arquivo de texto contendo os resultados de cada componente, associado à ima-
gem	que	contém	os	identificadores	únicos	para	cada	nó	e	cada	conexão,	pode-se	gerar	um	novo	

 
Figura 37.	Resultado	da	identificação	dos	componentes	que	compõem	o	foreground da paisagem da UAP1214.
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Figura 38. Arquivo de saída gerado para a UAP 1214 pela operação que permite o cálculo da diferença de probabilidade 
de conectividade dPC e da importância normalizada dos nós e das conexões da rede, o número de conexões de cada 
componente, e sua área (em pixels).   

 

(b)

(a)

(c)

mapa, ilustrando a importância dos conectores existentes na paisagem (Figura 39), conforme des-
crito a seguir:

a. Transferir os dados presentes no arquivo de texto para uma planilha, contendo quatro cam-
pos: ID (Link ID/Node ID); pixels; dPC; e normalized.importance. Salvar e abrir no ArcMap.

b. No ArcMap, abrir a imagem resultante do cálculo da importância das conexões e dos nós 
da	rede	contendo	os	códigos	de	identificação,	anteriormente	descrita	(arquivo	de	nome	com	
sufixo	“_cs_ids.tif”).	Converter	esse	arquivo	raster para o formato shapefile, por meio da ferra-
menta “Raster to Polygon”.

c. Utilizando a ferramenta “Selection by Attributes”, localizada na janela “Selection” do menu 
principal do ArcMap, selecionar os elementos do arquivo shapefile contendo a importância 
das conexões e dos nós da rede que possuam valores negativos na coluna “GRIDCODE”. 
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Clicar com o botão direito no referido arquivo, localizado na “Table Of Contents”, e exportar a 
seleção como um novo arquivo shapefile, seguindo o caminho “Data > Export Data”, originan-
do-se um novo arquivo apenas com as feições correspondentes aos nós (que correspondem 
às áreas de habitat interior) da paisagem. Na tabela de atributos do shapefile contendo a im-
portância das conexões e dos nós da rede, inverter a seleção, tendo-se dessa vez apenas as 
feições com valores positivos para a coluna “GRIDCODE” selecionadas. Exportar a seleção 
da mesma maneira como feito no passo anterior, originando-se um arquivo apenas com as 
conexões (que correspondem às áreas de pontes) da paisagem.

d. Clicar com o botão direito do mouse em cada novo arquivo criado por meio da seleção e realizar 
a união da sua tabela de atributos com a tabela das estatísticas originada do GuidosToolbox 
pelo cálculo da importância dos nós e conexões, utilizando os campos “GRIDCODE” e “ID”, 
conforme demonstrado na Figura 40.

e. Para a legenda desse mapa são utilizados tons de verde e vermelho. As cores verdes são em-
pregadas na visualização dos nós (habitat interior), enquanto o vermelho é usado para repre-
sentar as conexões (pontes). Quanto maior a intensidade das respectivas cores, maior será 
a importância do nó ou conexão. Para sua aplicação basta abrir as propriedades do arquivo, 
clicando-se com o botão direito e selecionando a opção “Properties”. Na aba “Symbology” se-
lecionar a opção “Quantities > Graduated Colors”; e no campo “Value” selecionar a coluna que 
contenha	os	valores	de	importância	normalizada.	Classificar	em	cinco	classes,	com	intervalos	
iguais.

Figura 39. Janela do ArcMap contendo o mapa de importância dos conectores existentes na paisagem da UAP1214.
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(b)(a)

1.5.2.1 Índices de importância dos conectores existentes na paisagem

Do cálculo da importância dos conectores existentes na paisagem derivam três índices, dados em 
valores percentuais:

•	dPC total: corresponde à somatória dos dPCs de todos os nós e conexões existentes na 
paisagem.

•	dPC do habitat: corresponde à somatória dos dPCs de todos os nós (áreas de habitat interior) 
existentes na paisagem.

•	dPC das conexões: corresponde à somatória dos dPCs de todas as conexões existentes na 
paisagem.

Na Tabela 12 são apresentados os índices de importância das conexões existentes na paisagem 
da UAP1214:

Tabela 12. Índices de importância das conexões existentes na paisagem da UAP1214.

Σ	dPC	total Σ	dPC	habitat Σ	dPC	conexões
28,5044 11,3081 17,1963

Figura 40. Janelas do ArcMap demonstrando o processo 
de união de uma tabela externa com um arquivo vetorial 
em um projeto.
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1.5.3 Elaboração dos arquivos de entrada para o Conefor

Além das análises de conectividade descritas anteriormente, o GuidosToolbox permite a geração 
de arquivos de entrada de nós e conexões para posterior análise no Conefor (Saura; Torné, 2009), 
permitindo uma análise detalhada da teoria dos grafos, que está além da importância da conectivi-
dade no GuidosToolbox. Para gerar tais arquivos de entrada deve-se:

a. A partir da segmentação MSPA da imagem, recalcular os componentes da rede (NW 
Components), podendo-se, então, acessar o comando “Image Analysis > Network > MSPA 
Conefor Inputs”. A partir desse comando serão gerados dois arquivos de texto (txt) contendo 
os nós (nodes) e conexões (links) da paisagem, que servirão para a análise de importância 
dos conectores existentes na paisagem.

b. Para executar tal análise deve-se utilizar o programa chamado Conefor, que pode ser obtido 
acessando-se o site <http://www.conefor.org/coneforsensinode.html>. Selecionar a opção de 
download do “Conefor 2.6 with graphical user interface”. Descompactar os arquivos e execu-
tar o programa Conefor 2.6 (Figura 41).

 

c. Na janela principal do Conefor (Figura 42 (a)) deverão ser inseridos os arquivos resultantes 
da geração das informações de nós e conexões obtidos com o uso da ferramenta “Conefor 
Inputs”, em GuidosToolbox,	usando	as	especificações	apontadas	na	Figura	42	(a),	clicando	
em “Run”. Os resultados da análise podem ser visualizados, ou armazenados, por meio da 
opção “Results > Overall index values > View” ou “Save as txt file”. Os resultados aparecem 
conforme ilustrado pela Figura 42 (b), apresentando os índices PCnum, EC(PC) e PC.

Figura 41. Estrutura de pastas do programa Conefor, ilustrando a localização do arquivo executável.
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1.5.3.1 Índices de conectividade gerados pelo Conefor

Dessa análise utilizam-se dois índices:

•	 Índice de probabilidade de conectividade (Probability of connectivity index, PC) e;

•	 Índice de área equivalente (Equivalent connected area, EC (PC));

O Índice de Probabilidade de Conectividade (Probability of connectivity index, PC) é uma métrica de 
paisagem	adimensional	que	quantifica	a	conectividade	funcional	do	habitat	(Saura;	Rubio,	2010),	
baseada em um modelo de conexão probabilística, onde uma certa probabilidade de dispersão (no 
caso	de	flora)	ou	de	movimento	(no	caso	de	fauna)	caracteriza	as	conexões	(pontes)	entre	dois	nós	
(áreas	de	habitat	interior).	Assim,	este	índice	pode	ser	definido	como	a	probabilidade	de	que	dois	
pontos, colocados aleatoriamente dentro da paisagem, caiam em áreas que são acessíveis entre si 
(interligadas), dado um conjunto de n fragmentos e conectores (conexões diretas) entre eles (Saura, 
2006). No caso da UAP1214, utilizada como exemplo, o valor obtido para esse índice foi de 0,26.

Por sua vez, o Índice de Área Equivalente (Equivalent connected área, EC (PC)), corresponde a um 
índice geral de conectividade, assim como o PC. No entanto, seu uso é preferível a este, no sentido 
de ser expresso em unidades de área, além de possibilitar comparações entre diferentes UAPs. 
Este	índice	pode	ser	definido	como	sendo	o	tamanho	que	um	único	fragmento	(área	de	habitat	inte-
rior) maximamente conectado deveria ter para ser capaz de atingir o mesmo valor do índice PC que 
o padrão real dos fragmentos da paisagem está atingindo. Para a UAP1214 esse índice apresenta 
valor igual a 2.049.283,00. Quanto maiores os valores de PC e EC (PC), maior a importância das 
conexões existentes.

 

(a)

 

(b)

Figura 42. Janelas do Conefor, mos-
trando	as	especificações	para	a	análise	
da conectividade na paisagem (a), bem 
como os respectivos índices derivados 
(b).
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1.6 Análise da fragmentação

A fragmentação pode ser vista como a heterogeneidade espacial, ou a composição e arranjo es-
pacial de objetos de interesse em uma imagem. Leva em consideração o número de objetos e a 
distância entre eles, abordando, portanto, características do primeiro plano e também do plano de 
fundo, ao mesmo tempo. Devido à sua natureza holística, a descrição da fragmentação é bastante 
complexa.	No	caso	de	paisagens,	é	normalmente	definida	com	base	em	determinada	espécie	de	
interesse	e,	como	tal,	pode	ser	muito	específica.	

As	definições	de	fragmentação	existentes	são	apenas	descritivas	e	por	esta	razão	não	permitem	
quantificar	o	grau	ou	mudanças	na	fragmentação	para	uma	dada	imagem.	Tipicamente,	a	fragmen-
tação é tratada como um descritor sumário que aborda uma variedade de atributos espaciais em um 
mapa	com	a	cobertura	florestal,	tais	como:	a	área	total	de	floresta,	tamanho	médio	de	fragmentos,	
número de fragmentos, agregação espacial e/ou dispersão dos fragmentos, compacidade, quan-
tidade	de	bordas	de	floresta,	quantidade	de	clareiras	dentro	das	florestas,	conectividade	entre	os	
fragmentos, entre outras (Vogt, 2018a).

1.6.1 Fragmentação hipsométrica

Para	quantificar	a	fragmentação	serão	aqui	aplicados	conceitos	diferentes	daqueles	tradicionais.	O	
índice de fragmentação adotado tem o seu valor normalizado no intervalo [0% a 100%]. Além de 
quantificar	o	estado	de	fragmentação	em	uma	determinada	área,	este	índice	permite	a	comparação	
do	grau	de	fragmentação	de	diferentes	locais,	a	quantificação	das	alterações	na	fragmentação	e	
seu monitoramento ao longo do tempo, bem como a avaliação do progresso em programas de pla-
nejamento e na implementação de diretrizes políticas.

Ao utilizar a opção Hypsometry, localizada no menu “Image Analysis > Fragmentation > Index > 
Hypsometry” (Figura 43), adotando como arquivo de entrada o mesmo arquivo utilizado na gera-43), adotando como arquivo de entrada o mesmo arquivo utilizado na gera-), adotando como arquivo de entrada o mesmo arquivo utilizado na gera-
ção da análise MSPA, pode-se calcular o histograma da distância euclidiana da fragmentação da 
imagem. Como resultados são obtidas uma curva hipsométrica simples e uma curva hipsométrica 
normalizada, bem como a imagem com a representação espacial dos valores obtidos (Figura 45). A 
legenda contendo a amplitude das classes, a escala de cores adotadas e seus respectivos valores 
no modelo de cores RGB podem ser observados na Tabela 13. A barra de título do GuidosToolbox 
apresenta valores de fragmentação para a imagem inteira, para o primeiro plano (foreground) e 
também os valores mínimo e máximo da amplitude de variação da imagem como um todo (Figura 
45, item 1). Abaixo da janela de exibição da imagem, há um painel que apresenta a opção de divisão 
da amplitude de valores em classes de distância pequena, média e grande, disponível clicando-se 
em “Divide”. (Figura 45, item 2).

Figura 43. Posicionamento do botão de ativação da análise de fragmentação por meio da distância euclidiana (Hypso-
metry) no GuidosToolbox.
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Figura 44. Curva hipsométrica da distribuição das distâncias euclidianas no primeiro plano e no segundo plano(a), e curva 
hipsométrica normalizada para o mínimo (preto), máximo (vermelho), e o estado atual da fragmentação para o primeiro 
plano (verde) e o segundo plano (azul) em (b).

(b)(a)

 
Figura 45. Imagem gerada pelo cálculo da distância euclidiana resultando no Índice de Fragmentação Hipsométrico. Na 
barra de título do programa (1) são apresentados o Índice de Fragmentação Hipsométrico calculado para a imagem toda 
e também o índice calculado quando considerado somente o segundo plano (background, BG) e somente o primeiro plano 
(foreground, FG). No painel Divide, abaixo da janela, os valores de fragmentação podem ser agrupados em classes de 
distância, pequena, média e grande, de acordo com limiares estabelecidos pelo usuário (2).
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A curva hipsométrica é uma descrição sumária do histograma de distâncias euclidianas. Ao 
visualizar a imagem da distribuição de distâncias como um mapa de pseudoelevação, a curva 
hipsométrica resume o relevo ou curvas de nível no primeiro plano (foreground). O mesmo processo 
é conhecido como batimetria quando realizado para o plano de fundo (background). A Figura 44 (a) 
mostra as frequências acumuladas das distâncias euclidianas, bem como as seguintes estatísticas 
relacionadas com o background e o foreground:

•	 Índice Hipsométrico (Hypsometric Index (HI)): adb/bgmax ou adf/fgmax.

•	Área Hipsométrica (Hypsometric Area (HA)): área integral abaixo da curva.

•	Distância média (Average distance): adb/adf.

•	Distância máxima (Maximum distance): bgmax/fgmax.

•	Número de objetos (Number of objects): bgobj/fgobj.

•	Área total dos objetos (Total area of objects): bgarea/fgarea.

•	Área Representativa (Representative area): bgArep/fgArep.

Onde: 

adb: distância média no segundo plano.

bgmax: distância máxima no segundo plano.

adf: distância média no primeiro plano.

Tabela 13. Amplitude das classes, tonalidades das cores e valores no modelo de cores RGB das classes de fragmentação 
hipsométrica da paisagem.

Amplitude de classe R G B Cor Amplitude de classe R G B Cor 

< -45 255 0 255 00 a 05 180 255 75

-45 a -40 189 0 255 05 a 10 243 255 11

-40 a -35 130 0 130 10 a 15 255 203 0

-35 a -30 0 0 175 15 a 20 255 139 0

-30 a -25 0 0 255 20 a 25 255 0 0

-25 a -20 0 80 255 25 a 30 200 0 0

-20 a -15 0 150 255 30 a 35 130 0 0

-15 a -10 0 180 255 35 a 40 0 255 0

-10 a -05 0 220 255 40 a 45 0 180 0

-05 a 00 0 255 255 > 45 0 101 0
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fgmax : distância máxima no primeiro plano.

bgobj: número de objetos no segundo plano.

fgobj: número de objetos no primeiro plano.

bgarea: área no segundo plano.

fgarea: área no primeiro plano.

bgArep: área representativa no segundo plano.

fgArep: área representativa no primeiro plano.

A Área Representativa (Arep) é calculada para um objeto similar, de forma circular, com um raio 
igual à razão entre a área representativa do primeiro plano (adf) e a área representativa do segundo 
plano (adb).	Da	mesma	forma,	um	objeto	quadrado	representativo	pode	ser	definido	com	o	com-
primento de aresta igual à raíz quadrada da Área Representativa (Arep). Tal como acontece com a 
distância média (adf/adb), as mudanças na Área Representativa são indicativos dos processos de 
fragmentação. Para uma dada imagem, o grau de fragmentação corresponde à área coberta entre 
a fragmentação mínima (preto) e fragmentação máxima (vermelho). Na Figura 44 (b) esta área é 
destacada em azul para o segundo plano e em verde para o primeiro plano. Considerando a nature-
za dual da fragmentação (o primeiro plano é fragmentado pelo segundo plano e vice-versa), o grau 
de	fragmentação	para	uma	determinada	imagem	(Equação	3)	é	definido	pela	soma	ponderada	da	
fragmentação no primeiro plano e no segundo plano:

Onde: 

bgfrag: fragmentação no segundo plano.

fgfrag: fragmentação no primeiro plano.

A Curva Hipsométrica Normalizada (Normalized Hypsometric Curve - NHMC) é a Curva Hipsométrica 
escalada pela distância máxima do primeiro e do segundo planos. Ilustrada na Figura 44 (b), essa 
curva mostra o NHMC para três imagens com a mesma dimensão que a imagem real e as três se-
guintes condições:

1. Fragmentação mínima (preto): NHMC de uma imagem do primeiro plano com a agregação 
máxima: todos os pixels do primeiro plano acumulados para um círculo no centro da imagem. 
Se a cobertura do primeiro plano é muito grande para caber um círculo na imagem, um retân-
gulo é utilizado.

2. Imagem real (azul / verde): NHMC da imagem sendo analisada.

3. Fragmentação máxima (vermelho): NHMC de uma imagem tipo tabuleiro de damas com co-
bertura de 50%. Esta condição máxima teórica para a fragmentação é caracterizada por todos 

fgarea

100 x bgfrag

Frag (hypso) = (                   ) + (                   )
bgarea

100 x bgfrag

Equação (3)
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os pixels do primeiro plano e do segundo plano com distância igual a 1, resultando, assim, na 
função escalonada delineada em vermelho na Figura 44 (b).

1.6.1.1 Índices de fragmentação hipsométricos

A análise da fragmentação acima exposta considera aspectos como dualidade, perfurações, quan-
tidade, divisão e dispersão dos objetos na imagem, originando três índices principais, com seus 
valores normalizados no intervalo [0 – 100%]:

•	Fragmentação da cobertura arbórea/arbustiva natural: corresponde à fragmentação no pri-
meiro plano da imagem (fgfrag).

•	Fragmentação dos demais tipos de cobertura: corresponde à fragmentação no segundo 
plano da imagem (bgfrag).

•	Fragmentação de acordo com a hipsometria: corresponde à soma ponderada da fragmen-
tação do primeiro plano com a fragmentação do segundo plano da imagem (frag).

No caso da UAP1214, foram obtidos índices com valores iguais a 61,24%, 58,33% e 60,37% para 
a fragmentação da cobertura arbórea/arbustiva natural, do segundo plano e a média ponderada, 
respectivamente. Quanto mais próximo de 100%, mais fragmentada será a paisagem.

1.6.2	 Densidade	de	área	florestal	

A	fragmentação	florestal	é	um	tópico	bastante	complexo,	dependente	da	escala	e	do	observador	
(Vogt, 2018a). Para este autor não existe uma única escala ou observador que não sejam arbitrá-
rios, de forma que a solução é relatar a fragmentação em múltiplas escalas, permitindo que diferen-
tes observadores possam fazer suas próprias escolhas referentes à escala e aos limites de decisão, 
dependendo do objetivo da análise.

No submenu “MultiScale” do GuidosToolbox são fornecidas metodologias para análise da frag-
mentação em diferentes escalas de observação. É o caso da análise denominada Densidade de 
Área Florestal (Forest Area Density - FAD), construída por meio da medida da Proporção de Pixels 
de Floresta em uma janela móvel (métrica denominada P2 por Vogt, 2018a), considerando que, 
no estudo-piloto apresentado como exemplo, o primeiro plano da MSPA inclui, além da cobertura 
florestal,	também	a	cobertura	arbustiva.	A	ferramenta	utiliza,	como	padrão,	cinco	escalas	de	obser-
vação, com janelas móveis de diferentes tamanhos e áreas de vizinhança, contendo 7, 13, 27, 81, e 
243 pixels. Estas janelas móveis percorrem a imagem contendo a máscara do primeiro plano (Vogt, 
2018b), a exemplo do realizado anteriormente na análise do mosaico da paisagem e tal como reali-
zado por Riitters et al. (2002, 2012a, 2012b). As diferentes áreas de vizinhança foram selecionadas 
visando abranger uma ampla gama de escalas, de modo que exista uma progressão geométrica 
aproximada das áreas das janelas juntamente com a escala (Vogt, 2018a). 

O arquivo de entrada para a análise FAD deve ser um arquivo raster composto por valores de 1 byte 
para o segundo plano e 2 bytes para o primeiro plano. A imagem preparada para a análise MSPA, 
conforme descrito no item “1.2.1 Preparação dos dados para a MSPA”, pode ser utilizada também 
na análise FAD. A análise FAD considera que todos os pixels do segundo plano irão atuar como 
agentes fragmentadores do primeiro plano. Opcionalmente, o arquivo de entrada pode ter os valo-
res de 0 byte para dados ausentes, 3 para	segundo	plano	específico,	como	água,	por	exemplo,	4	
para segundo plano não fragmentador, pertencente a algumas classes de uso e cobertura da terra 
que não tenham ação fragmentadora no primeiro plano, como campos nativos e formações naturais.
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Para	gerar	o	resultado	da	FAD	basta	abrir	a	imagem	codificada	e	acessar	a	opção	FAD,	a	partir	do	
menu Image Analysis (“Image Analysis > Fragmentation > MultiScale > FAD”) (Figura 46). O resul-
tado dessa análise é composto por um conjunto de cinco mapas (um para cada escala de observa-
ção), mostrando os valores da Densidade da Área Florestal de cada pixel do primeiro plano, para as 
diferentes áreas de vizinhança (Figura 47).	Cada	um	dos	cinco	mapas	do	FAD	é,	então,	classificado	
nas	seis	classes	de	fragmentação	da	floresta,	exibidas	na	Tabela	14.

 

 

Figura 47. Mapas de fragmentação nas cinco escalas de observação (1 – 5) e o mapa agregado (multiescala) (6), para 
a UAP1214.

Figura 46. Posicionamento do botão de ativação da análise de fragmentação baseada na FAD.
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Em seguida é calculada, para cada uma das cinco escalas, a proporção de pixels do primeiro plano 
em	cada	classe	de	fragmentação	e,	então,	um	gráfico	de	barras	é	elaborado,	mostrando	a	frag-
mentação	da	floresta	(primeiro	plano)	em	cada	escala	de	observação	(Figura	48).	No	gráfico,	as	
diferentes escalas de observação são rotuladas como 1, 2, 3, 4, e 5, correspondendo às janelas de 
7, 13, 27, 81, e 243 pixels, respectivamente. Na Figura 48,	o	gráfico	ilustra	a	proporção	das	classes	
de fragmentação para as cinco escalas de observação na UAP1214. Considerando a área de pixel 
de 25 m² da imagem utilizada, as janelas 1, 2, 3, 4, e 5 correspondem às áreas de aproximadamente 
0.12, 0.42, 1.82, 16.42, e 147.62 hectares, respectivamente, para a UAP1214, utilizada como exem-
plo.	O	agrupamento	em	seis	classes	de	fragmentação	permite	a	localização	de	áreas	florestais	alta-
mente fragmentadas (classe de Floresta Rara, na cor vermelha), por exemplo, ou quaisquer outras 
classes	de	fragmentação	(Vogt,	2018a).	O	gráfico	de	barras	(Figura	48) e as estatísticas (Figura 49) 
resumem	a	análise	de	fragmentação	da	floresta	em	formato	tabular.

Tabela 14.	Definição	das	seis	classes	de	fragmentação,	de	acordo	com	a	amplitude	da	Densidade	de	Área	Florestal	(FAD)	
e as respectivas tonalidades de cores adotadas na legenda.

FAD Cor Amplitude FAD Cor Amplitude

1 Rare Forest FAD < 10% 4 Dominant Forest 60%	≤	FAD	<	90%

2 Patchy Forest 10%	≤	FAD	<	40% 5 Interior Forest 90%	≤	FAD	<	100%

3 Transitional Forest 40%	≤	FAD	<	60% 6 Intact Forest FAD = 100%

Fonte: Vogt (2018ab).

Figura 48.	Gráfico	de	barras	cumulativo,	para	as	cinco	escalas	de	observação,	incluindo	a	análise	multiescala	e	a	quanti-
dade	total	de	área	florestal	(foreground), número e tamanho médio dos fragmentos, para a UAP1214.
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Figura 49. Tabela resumo dos resultados da análise FAD, contendo o percentual de classes de fragmentação nas cinco 
escalas de observação e também para a análise multiescala.

Figura 50. Resultado da análise FAD para a UAP1214, exibindo o mapa de fragmentação multiescala.

Ao	final,	os	cinco	mapas	de	fragmentação	em	diferentes	escalas	são	agregados	em	um	mapa	su-
mário	multiescala,	exibido	ao	final	da	análise	(Figura	50).	Ao	mover	o	cursor	do	mouse	sobre	a	ima-50). Ao mover o cursor do mouse sobre a ima-). Ao mover o cursor do mouse sobre a ima-
gem, o painel de informação na parte inferior da janela apresenta as coordenadas (Figura 50, item 
1), seguido do valor da soma das classes (Figura 50, item 2), bem como a sequência das classes 
de fragmentação (Figura 50, item 3). As classes de fragmentação estão rotuladas com a letra inicial 
do nome da classe (do termo em inglês, “rare”, “patchy”, “transitional”, “dominant”, “interior”), e com 
a letra I maiúscula para a classe “Intact” (Figura 50, item 4). A classe de fragmentação multiescala 
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Tabela 15. Classes cumulativas de fragmentação para cinco escalas de observa-
ção, com os respectivos valores de linha de base para cada classe sumária e a 
tonalidade de cor adotada na legenda.

Fragmentation class Linha de base Classe sumária Cor

1 – 1 – 1 – 1 – 1 5 – 9 Rare

2 – 2 – 2 – 2 – 2 10 – 14 Patchy

3 – 3 – 3 – 3 – 3 15 – 19 Transitional

4 – 4 – 4 – 4 – 4 20 – 24 Dominant

5 – 5 – 5 – 5 – 5 25 – 29 Interior

6 – 6 – 6 – 6 – 6 30 Intact

Fonte: Vogt (2018ab).

As informações resultantes da análise FAD podem ser armazenadas em uma única imagem con-
tendo os resultados do padrão multiescala, utilizando as opções “Display Snapshot” ou “KML”, no 
menu “File > Save Image”. Ao utilizar a opção “GeoTiff” ou “Generic” um conjunto completo de in-
formações	será	armazenado	na	pasta	especificada	pelo	usuário,	contendo	os	seguintes	arquivos:

•	  <name>_FAD_1/5.tif: cinco imagens contendo as classes FAD, para as cinco diferentes esca-
las de observação (Figura 47).

•	 <name>_FAD_balplot.png:	gráfico	de	barras	cumulativo	para	as	classes	FAD	(Figura	48).

•	<name>_FAD_mscale.txt: resultados sumarizados para FAD (Figura 49).

•	<name>_FAD_mscale.csv: resultados sumarizados para FAD, em formato CSV (comma-sepa-
rated values), para importação em planilhas eletrônicas.

•	<name>_FAD_mscale.tif: imagem multiescala contendo as classes FAD sumarizadas (Figura 
50).

•	<name>_FAD_sum_classes.tif: imagem contendo os valores da soma de classes de FAD em 
multiescalas.

As imagens resultantes têm as seguintes atribuições de valores de bytes dos pixels:

•	101: cor cinza, referente aos pixels do segundo plano.

é derivada da comparação da soma observada para as classes de fragmentação nas diferentes 
escalas de observação com a soma de um valor estabelecido como linha de base, conforme apre-
sentado na Tabela 15. Devido ao aumento das áreas de vizinhança à medida em que se aumenta 
a escala de observação, a sequência de classes de fragmentação sobre as escalas de observa-
ção	mostrará	valores	decrescentes,	por	exemplo	6-6-5-5-4	significando	uma	variação	de	Floresta	
Intacta, em uma escala pequena de observação, para Floresta Interior ou Floresta Dominante em 
escalas de observação maiores. A sequência em um determinado local depende do padrão multies-
cala do primeiro plano nesse local.



72 DOCUMENTOS 321

•	102: cor branca, referente aos pixels dos dados ausentes.

•	105: cor azul escuro, referente aos pixels do segundo plano específico.

•	106: cor azul claro, referente aos pixels do segundo plano não-fragmentador.

1.7 Análises baseadas em distância

O menu “Distance” do GuidosToolbox fornece diversas opções para a análise da distância (Figura 
51): Distância Euclidiana (“Euclidean Distance”),	 Zonas	 de	 Influência	 (“Influence Zones”); e 
Proximidade (“Proximity”).	Para	imagens	em	formato	GeoTiff,	é	importante	saber	que	os	valores	de	
distância	dos	pixels	somente	serão	significativos	quando	estas	imagens	estiverem	em	uma	projeção	
de áreas equivalentes, como a Projeção Albers, adotada pelo componente geoespacial do IFN-BR. 

O arquivo de entrada para as análises de distância deve ser um arquivo raster composto por valores 
de 1 byte para o segundo plano e 2 bytes para o primeiro plano. A imagem preparada para a MSPA, 
conforme descrito no item “1.2.1 Preparação dos dados para a MSPA ”, pode ser utilizada também 
nas análises de distância. Na Figura 51 é apresentado o posicionamento dos botões que permitem 
dar início às análises de distância. No caso do componente geoespacial do IFN-BR, serão utilizadas 
as	análises	de	proximidade	e	das	zonas	de	influência,	descritas	a	seguir.

1.7.1	 Zonas	de	influência

Uma	zona	de	influência	é	definida	como	a	linha	externa	de	delimitação	de	igual	distância	que	separa	
determinados	objetos	do	primeiro	plano.	O	limite	de	uma	zona	de	influência	é	derivado	da	aplicação	
do operador morfológico de divisor de águas (watershed) ao mapa da distância euclidiana da área 
de segundo plano na imagem. Considerando-se a imagem em tons de cinza da distância euclidiana 
como uma imagem de uma superfície, cada mínimo local pode ser visto como o ponto de drenagem 
a partir do qual a água que cair sobre a superfície ao redor será drenada. Os limites dos divisores 
de água encontram-se sobre as cumeeiras. Pequenos objetos na imagem original podem produzir 
mínimos espúrios ao longo dos gradientes, o que leva à segmentação excessiva. Por esta razão, o 
tamanho	mínimo	do	objeto	padrão	definido	é	igual	a	5.000	pixels.	

Objetos omitidos menores que o tamanho mínimo são exibidos na cor azul claro. Os objetos para 
os	quais	as	zonas	de	influência	são	calculadas	são	exibidos	em	cores	alternadas.	Dados	faltantes	
são	exibidos	em	branco	e,	os	limites	das	zonas	de	influência	(linhas	dos	divisores	de	água),	em	cor	
preta.	Zonas	de	influência	são	calculadas	para	objetos	do	primeiro	plano	maiores	ou	iguais	à	área	
mínima	especificada	em	pixels,	que	pode	ser	definida	por	meio	do	parâmetro	“MSPA Edge Width”. 

 
Figura 51. Posicionamento do botão de ativação das análises baseadas em distância.
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Na Figura 52	pode-se	observar	o	 resultado	da	análise	para	as	zonas	de	 influência,	no	caso	da	
UAP1214. 

Adicionalmente,	o	painel	abaixo	da	janela	de	visualização	permite	a	definição	de	zonas-tampão	para	
ambos, primeiro e segundo planos. Neste caso, um valor diferente de zero para a zona-tampão do 
primeiro plano corresponde à largura do perímetro dos objetos do primeiro plano a serem excluídos 
do	cálculo.	Por	conseguinte,	este	parâmetro	pode	ser	utilizado	para	definir	objetos	de	habitat	interior	
do primeiro plano. Neste caso, os cálculos serão realizados para objetos de habitat interior do pri-
meiro	plano	com	área	mínima	especificada	pelo	parâmetro	MSPA EdgeWidth. Um valor diferente de 
zero para a zona-tampão do segundo plano irá adicionar uma zona de cor cinza escuro da largura 
especificada	ao	redor	e,	se	buracos	suficientemente	grandes	estiverem	presentes,	dentro	do	núcleo	
dos objetos do primeiro plano. Os limites da zona-tampão do segundo plano são representados em 
rosa	escuro.	Zonas	tampão	do	segundo	plano	encerram-se	nos	limites	das	zonas	de	influência.	Ao	
clicar no botão Divide abaixo da imagem, serão	reiniciadas	tanto	as	configurações	do	primeiro	plano	
e do segundo plano ao seu valor padrão igual a zero, omitindo zonas-tampão e mostrando apenas 
as	zonas	de	influência.	Em	resumo,	as	zonas	de	influência	fornecem	uma	classificação	dos	objetos	
especificados	pelo	usuário	e	as	zonas-tampão podem	ser	adicionadas	para	definir	áreas	de habitat 
interior, tanto quanto zonas “fora de alcance” de qualquer tamanho2.

 
Figura 52.	Resultado	da	análise	das	Zonas	de	Influência,	baseada	em	distância,	para	a	UAP1214.

2 O	limiar	de	pequenos	objetos	a	serem	excluídos	do	cálculo	pode	ser	definido	para	qualquer	valor	por	meio	do	menu	parâmetro	MSPA	“Edge	Width”.	Po-
dem	ser	selecionados	valores	pré-definidos	ou	especificados	valores	personalizados.	Um	novo	valor	personalizado	só	será	atribuído	após	pressionada	a	
tecla	Enter.	Ao	inserir	um	novo	valor	de	limite	para	a	exclusão	de	pequenos	objetos,	as	zonas	de	influência	serão	recalculadas	automaticamente.	Um	valor	
igual	a	1	(um)	irá	calcular	zonas	de	influência	para	todos	os	objetos	do	primeiro	plano.	Como	as	zonas	de	influência	foram	desenvolvidas	para	descrever	
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Ao	armazenar	uma	imagem	das	zonas	de	influência,	serão	produzidos	os	seguintes	arquivos	com	o	
prefixo	<nome>_influence_<Y>_<b1>_<b2>_<zoom>, em que Y representa o tamanho mínimo do 
objeto em pixels, b1 e b2 representam a largura selecionada para a zona-tampão do primeiro e do 
segundo	plano,	respectivamente,	e	o	sufixo	zoom será adicionado se uma sub-região da imagem 
for salva: 

a.	 prefix.tif:	imagens	conforme	exibidas	no	aplicativo	GuidosToolbox. 

b. prefix_ids.tif: imagens mostrando os rótulos exclusivos dos objetos, zonas-tampão, divisores 
de	águas,	e	etc.	usando	valores	negativos	para	dados	específicos	e	valores	positivos	para	os	
objetos individuais, com a seguinte notação: 

•	 6: zona-tampão.

•	 5: limite da zona-tampão.

•	 4: dados faltantes.

•	 3: divisores de águas.

•	 2: pixel do primeiro plano omitido.

•	 1: perfuração no primeiro plano.

•	 0: segundo plano.

•	 1-x:	identificador	único	dos	objetos	(ID).

1.7.2 Proximidade

A análise de proximidade mede a vizinhança de objetos adjacentes. Assim como no caso das Zonas 
de	Influência,	os	objetos	de	interesse	são	definidos	considerando-se	uma	janela	móvel	com	conec-
tividade	com	parâmetro	igual	a	8	e	uma	área	mínima,	que	pode	ser	definida	por	meio	do	parâmetro	
Edge Width	do	MSPA.	Objetos	com	área	menor	que	o	tamanho	mínimo	definido	são	exibidos	na	cor	
azul claro, enquanto a linha do divisor de águas (“watershed”) é representada em preto. Ao navegar 
com o ponteiro do mouse	pela	imagem,	será	exibido	na	barra	de	títulos	do	programa	o	identificador	
do componente e sua área associada em número de pixels, ou se corresponde a uma área de se-
gundo plano ou a algum objeto omitido da imagem. Na Figura 53 apresenta-se o resultado obtido 
para a UAP1214, por meio dessa ferramenta.

a região externa dos objetos, elas são calculadas para objetos “cheios” do primeiro plano. Por esta razão, os buracos no interior de objetos circundantes 
terão	o	mesmo	ID	do	objeto	externo	e,	por	conseguinte,	o	número	total	de	objetos	quando	calculadas	as	zonas	de	influência	pode	ser	menor	em	compa-
ração	com	o	número	total	de	identificadores	de	objetos	(IDs).
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Figura 53. Resultado da análise de Proximidade, baseada em distância, para a UAP1214.

Posicionando-se o mouse na linha do divisor de águas serão apresentadas, na barra de títulos do 
software, as coordenadas x/y da sua localização bem como as seguintes medidas (ilustradas na 
Figura 54):

•	Proximidade (Proximity): o valor de proximidade equivale à distância mais curta, medida em 
pixels, necessária para a conexão de dois objetos vizinhos. Assim, ao longo da linha que repre-
senta o divisor de águas, o valor de proximidade corresponde à distância mais curta para co-
nectar todos os objetos vizinhos. O ponto de menor distância entre dois fragmentos diferentes 
é representado na cor vermelha, como se pode observar no item 1 da Figura 54, onde apenas 
dois pixels são necessários para conectar os dois objetos vizinhos.

•	Ganho de área conectada – Connected Area Gain (CAG): o ganho de área conectada é uma 
medida que corresponde à quantidade de área obtida quando uma conexão é estabelecida 
entre dois componentes disjuntos em uma determinada localização. De maneira geral, quando 
dois objetos com áreas a e b são combinados, a área atingida se torna √ (a + b) = √ a2 + 2ab + b2. 
Nesse caso, o ganho de área obtido por meio do estabelecimento de uma nova conexão é igual 
a √ 2ab quando dois componentes são conectados, √ ab + 2ac + abc quando três componentes 
são conectados, e assim por diante. Por exemplo, na Figura 49, item 2, a proximidade entre os 
componentes com ID 6 e ID 9 é de 2 pixels. O ganho de área conectada nesse local será igual 
a: CAG = √ 2ab = √ 2 x 13.546 x 6.431 = 13.200.

•	Ganho relativo de área conectada - Relative Connected Area Gain (CAGrel) (%): o CAG rela-
tivo	é	definido	como	o	raio	do	CAG	para	a	área	total	de	todos	os	componentes	da	imagem.	
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Figura 54. Resultado da análise de Proximidade, baseada em distância, para a UAP1214, exibindo uma aproximação 
de um dos divisores de água, onde encontram-se destacados em vermelho os pixels de menor distância entre dois frag-
mentos diferentes para toda a imagem e onde apenas dois pixels são necessários para conectar os dois objetos vizinhos; 
conforme	se	pode	verificar	nas	informações	disponibilizadas	abaixo	da	imagem,	quando	o	cursor	do	mouse é posicionado 
sobre a área em vermelho são exibidos: a proximidade (item 1), o Ganho de Área Conectada (CAG ) (item 2) e o Ganho 
Relativo de Área Conectada (CAGrel) (item 3), entre duas componentes da paisagem.

 

Percentuais maiores implicam que uma área maior será reconectada e, consequentemente, 
indica	uma	maior	eficiência	na	conexão	estabelecida	em	uma	determinada	localidade.	No	caso	
da UAP1214, a conexão ilustrada na Figura 54 (item 3) resultaria em um ganho relativo de 1%.

Assim, de maneira geral, o módulo “Proximidade” pode ser usado para examinar o entorno de ob-
jetos vizinhos, enquanto o “CAG” mede a importância (relativa) de qualquer valor de proximidade. 
As estatísticas de proximidade para toda a imagem podem ser obtidas ao ativar a opção “Intext” no 
menu “MSPA Settings”, fornecendo as três ações apresentadas na sequência (Figura 55): 

a. Histograma do CAG:	em	uma	nova	janela	um	gráfico	será	gerado,	exibindo	a	série	de	valores	
CAG obtidos (mínimo, médio, máximo) para cada valor de proximidade encontrado, ao longo 
da linha do divisor de águas. A faixa de proximidade padrão varia de [0, prox_max]. Ao clicar 
no botão azul destacado no item 1 da Figura 55	(a),	0	gráfico	irá	exibir	os	dados	para	a	faixa	
de proximidade total (Figura 55 (b)). Além disso, o CAG máximo encontrado na imagem, bem 
como a sua localização (coordenadas x/y), serão apresentados em cor vermelha na área do 
gráfico.

b.	 Histograma	de	Frequências:	em	uma	nova	janela	um	gráfico	será	gerado	exibindo	a	frequên-
cia que um dado valor de proximidade é encontrado ao longo da linha do divisor de águas. 
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Figura 55. Exemplo ilustrando o resumo dos resultados de “Proximidade” e “Ganho de Área Conectada - CAG” para 
toda a imagem: (a) valor de CAG para conectores com diferentes comprimentos de Proximidade, podendo-se clicar no 
ícone de expansão da janela (item 1) para visualizar a faixa de proximidade completa, ilustrada em (b); (c) frequência de 
proximidade ao longo do divisor de águas; (d) planilha com o resumo das estatísticas.

A	faixa	de	proximidade	padrão	varia	de	[0,	prox_max].	O	gráfico	apresentando	o	histograma	
para a faixa de proximidade total é exibido na Figura 55 (c).

c. Planilha com o resumo das estatísticas: essa planilha é gravada no disco em formato CSV 
(comma separated values) contendo: informações a respeito da localização, proximidade, 
CAG, número, ID e área dos objetos para cada local do divisor de águas (Figura 55 (d)). Esse 
arquivo	pode	ser	importado	e	seus	dados	podem	ser	classificados	de	acordo	com	a	proprie-
dade de interesse; por exemplo, para encontrar a localização x/y que fornece os valores mais 
elevados de CAG ou para listar todos os valores de CAG e a localização espacial de um dado 
comprimento de conector (proximidade).

Ao	 salvar	 a	 análise	 de	 proximidade	 serão	 gerados	 os	 seguintes	 cinco	 arquivos	 com	 o	 prefixo	
<name>_proximity_<Y>_<b1>_<b2>_<zoom>, onde Y representa o tamanho mínimo selecio-
nado para o objeto em pixels, b1 e b2 correspondem aos valores selecionados para os campos 
“CoreZone” e “Prox_max”,	respectivamente,	e	o	sufixo	zoom será adicionado se uma sub-região da 
imagem for salva: 

a.	 prefix_CAG.tif:	imagem	ilustrando	os	valores	de	CAG	ao	longo	da	linha	do	divisor	de	águas.

 
 
 

 

(b)

(c)

(a)

(d)
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b.	 prefix_viewport.tif:	gráficos	iguais	aos	exibidos	na	interface	do	aplicativo	GuidosToolbox.

c.	 prefix.csv:	estatísticas	para	os	valores	de	Proximidade/CAG.

d.	 prefix_ws.tif:	imagem	ilustrando	os	valores	de	proximidade	na	linha	do	divisor	de	águas.

e.	 prefix_ids.tif:	imagem	contendo	valores	positivos	para	os	identificadores	únicos	dos	objetos	e	
valores negativos para dados especiais, com a seguinte notação:

•	 -4: dados omitidos ou ausentes.

•	 -3: divisor de águas.

•	 -2: pixels omitidos do primeiro plano.

•	 -1: perfuração no primeiro plano.

•	 0: segundo plano.

•	 1-x:	identificador	único	do	objeto.

1.8 Reconexão

O menu “Cost” do GuidosToolbox fornece diversos módulos projetados para realizar análises de cus-
to (Figura 56): “Cost Map A”, “Cost Map AB”; e “Reconnect”.	Ao	utilizar	dados	em	formato	GeoTiff,	os	
valores	de	distância	dos	pixels	somente	serão	significativos	para	imagens	quando	estas	estiverem	
em uma projeção de áreas equivalentes (Vogt, 2018). Para análise dos dados da componente de 
paisagem do IFN-BR foi escolhida a ferramenta “Reconnect”, apresentada na sequência.

 
Figura 56. Posicionamento do botão de ativação das análises baseadas em custo.

Essa opção de análise fornece uma interface para examinar possíveis vias de reconexão e/ou de-
tectar pontos de ligação, conhecidos como stepping-stones na área de ecologia de paisagens, entre 
componentes existentes, e funciona em três etapas (Vogt, 2018):

a. Definição	dos	componentes	de	 interesse: os componentes de interesse devem ter sua 
área	mínima	definida	(a	opção	default do software é de 5.000 pixels). De forma similar à aná-
lise	das	Zonas	de	Influência,	os	componentes	de	interesse	podem	ser	definidos	por	sua	área	
(via o parâmetro do MSPA SETTINGS “Edge Width” (Figura 57, item 1)) ou pela remoção de 
pixels	de	borda	para	a	definição	de	um	componente	de	habitat	interior	(Core) (por meio do 
painel “Division” em “CoreZone” (Figura 57, item 2)).
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b. Resistência: o cálculo do custo é baseado nos valores de resistência relativa presentes nos 
pixels da imagem: todos os pixels do primeiro plano (componentes de interesse são apresen-
tados em verde, enquanto os componentes omitidos do primeiro plano são apresentados em 
azul	claro)	têm	resistência	igual	a	1%;	pixels	classificados	como	Dados	Ausentes,	com	valor	
igual	a	0	(apresentados	em	branco),	apresentam	resistência	infinita;	todos	os	pixels	do	segun-
do	plano	(apresentados	em	cinza)	têm	o	mesmo	valor	de	resistência,	que	pode	ser	definido	no	
campo “BGresist” abaixo da janela de visualização (Figura 57, item 3). O valor de resistência 
padrão do software é	igual	a	2%.	Para	aplicar	qualquer	novo	parâmetro	definido	deve-se	clicar	
em “Divide” (Figura 57, item 4).

c. Definição	do	componente	inicial/alvo: clicando no parâmetro MSPA SETTINGS “FGConn” 
(Figura 57, item 5) uma nova janela se abre com informações indicando o procedimento para 
configurar	a	imagem	para	a	geração	do	caminho	de	menor	custo	(Least Cost Path - LCP). 
As informações apresentadas indicam que é necessária a realização de dois passos para a 
identificação	dos	marcadores	para	a	 ferramenta	de	 reconexão	 (Reconnect Marker Image): 
a	identificação	do	componente	“A”	inicial	e	a	identificação	do	componente	“B”	final.	Informa,	
ainda, que instruções serão fornecidas na barra de exibição abaixo da janela de visualização 
e que o usuário pode utilizar a aproximação (ferramenta zoom), caso necessário. Em seguida, 
requer	que,	ao	final	da	leitura,	o	usuário	selecione	a	opção	“Sim”	para	configurar	o	“Reconnect 
Marker Image” (Figura 58 (a)). Para a seleção do componente inicial “A” deve-se clicar sobre 
o componente de interesse e, em seguida, pressionar a tecla Enter e em seguida Accept na 

 
Figura 57. Janela principal do GuidosToolbox indicando	as	opções	que	permitem	a	 configuração	dos	parâmetros	de	
ajuste para a análise “Reconnect”.
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janela	que	se	abre,	confirmando	a	seleção	(conforme	descrito	na	barra	inferior	de	informações	
do software, apresentada na Figura 58	(b)).	Definido	o	“Component A”, seguindo-se as ins-
truções na barra de exibição abaixo da janela de visualização (Figura 58	(b),	(c)	e	(d)),	definir	
o “Component B”	que	representa	o	destino	final	do	caminho	de	menor	custo	(Figura	58 (e)). 
Após selecionados os componentes de interesse, uma janela de informações será aberta, 
apresentando os valores de resistência utilizados para o segundo plano e o primeiro plano 
(Figura 58 (f)).

d. Cálculo da reconexão:	após	a	definição	dos	componentes	inicial	e	final,	clicando	no	MSPA 
SETTINGS “FGConn” (Figura 57, item 5), novamente será calculado o caminho de menor 
custo (Least Cost Path – LCP) e exibido na cor magenta na imagem apresentada na janela 
principal do software. Na Figura 59 ilustra-se esse resultado para a UAP1214, conectando 
os componentes 2 e 4 (item 4), cujo Ganho de Área Conectada relativo (CAG) seria de 28% 
(itens 2 e 3), a partir da restauração de 3 pixels do segundo plano (item 1).

O	critério	utilizado	para	a	definição	dos	Fragmentos	A	e	B	a	serem	conectados	em	cada	UAP	é	o	
de Ganho de Área Conectada, selecionando-se os dois componentes com maiores valores de CAG 
na paisagem. As informações estão disponíveis na tabela resultante da Análise de Proximidade 
(<NAME>_proximity_500_0_0.csv), que apresenta os valores de CAG para todas as possíveis co-
nexões na paisagem. Ordenando-se os valores de CAG do maior para o menor, conforme descrito 
no item (c) do tópico “1.7.2 Proximidade”, é possível conhecer a conexão indicada entre os dois 
fragmentos que irão gerar o maior valor de CAG.

Figura 58. Janelas auxiliares do GuidosToolbox guiando	o	procedimento	para	configuração	do	caminho	de	menor	custo	
(Least Cost Path - LCP) entre dois fragmentos.  

(b)

 

(c)

 

(d)

 

(a)

 

(f)

 

(e)
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1.9 Análise das zonas ripárias

A metodologia adotada para avaliação das zonas ripárias, no âmbito das análises realizadas em 
escala de paisagem no IFN-BR, baseia-se na conectividade estrutural destes ambientes como 
corredores de vegetação, no grau de pressão antrópica atuando sobre eles e na simulação de 
cenários para zonas de proteção ripária. São calculados índices integrados - depois transformados 
em scores	-	para	efetuar	um	ranqueamento	que	permite	a	identificação	de	áreas	prioritárias	para	a	
restauração da paisagem, a exemplo do que foi realizado na Europa por Clerici et al. (2011).

A metodologia desenvolvida por Clerici et al. (2011) foi adaptada para análise das UAPs do IFN-BR, 
já	que	não	se	dispõe	de	um	mapa	compreensivo	das	Zonas	de	Influência	Ripária	para	o	território	
nacional.	Assim,	estabeleceu-se	um	valor	fixo	para	delimitá-las	-	a	exemplo	do	proposto	por	Ivits	et	
al. (2009) - considerando a faixa máxima exigível pelo Código Florestal, que é de 500 m ao longo 
de cada margem, para rios com 600 m de largura ou mais, em áreas de preservação permanente 
não consolidadas. 

A análise de conectividade estrutural se inicia com a aplicação da MSPA descrita na Seção 1.2. Em 
seguida é gerado um grid poligonal de espaçamento 100 m x 100 m (células de 1 hectare) sobre 
toda a área da UAP e construída uma máscara correspondente à zona ripária (500 m de largura 
ao longo das margens dos rios). Todas as análises subsequentes serão realizadas apenas dentro 
dessa máscara e os índices serão calculados para cada célula de 1 hectare.

Figura 59. Resultado da Análise de Reconexão para a UAP1214, onde a linha tracejada na cor magenta ilustra o caminho 
de menor custo para a conexão dos dois componentes da paisagem de maior valor CAG. Os itens 1, 2, 3 e 4 corres-
pondem à quantidade de pixels a serem restaurados, ganho de área conectada absoluto e relativo e os componentes 
considerados na análise, respectivamente.
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O índice pode ser calculado aplicando-se a Equação 4:

Bc

S
ICEc = Equação (4)

Primeiramente são selecionados os polígonos das classes “Ponte” (Bridge) e “Habitat Interior” (Core) 
resultantes da análise MSPA dentro da máscara da zona ripária, selecionando-se em seguida as cé-
lulas do grid onde ocorrem estes polígonos nas zonas ripárias (Figura 60). O Índice de Corredores 
Estruturais (ICEc) revela a proporção da superfície ocupada pelas classes “Ponte” e “Habitat Interior” 
em cada célula c de 1 ha (100 m x 100 m). Regiões com densas redes de drenagem e extensas 
áreas naturais apresentam alto ICEc. 

Figura 60. Zonas ripárias estabelecidas com base em buffers de 500 m de largura ao longo dos rios da UAP1214 e 
polígonos correspondentes às classes Ponte e Habitat Interior na análise MSPA, com respectiva legenda.

Grid 100 m x 100 m
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Onde:

Bc = superfície ocupada pelas classes Ponte e Habitat Interior (em ha) na célula c.

S = área da célula c (= 1 ha).

O Índice de Corredores Estruturais sob Pressão Antrópica (ICEA , Equação 5) representa uma in-5) representa uma in-) representa uma in-
tegração entre o ICEc e informações sobre a proporção de áreas não-naturais (urbanizadas e agrí-
colas) nas células c de 100 m x 100 m, que contém polígonos pertencentes às classes “Ponte” ou 
“Habitat	 Interior”.	Sua	aplicação	permite	 identificar	onde	há	presença	significativa	de	corredores	
ripários estruturais e, ao mesmo tempo, de paisagens antrópicas. Primeiramente calcula-se a pro-
porção da superfície ocupada por classes de uso antrópico em cada célula de 1 ha (Ac), que pode 
ser obtida a partir da sobreposição do mapa de uso e cobertura da terra sobre as células do grid de 
100 m x 100 m em que ocorrem as classes Ponte e Habitat Interior. Em seguida aplica-se a fórmula 
do índice (Equação 5):

ICEA  = ICEc x Ac

Onde:

ICEc = Índice de Corredores Estruturais na célula c.

Ac = proporção da superfície ocupada por classes de uso antrópico em cada célula c.

Já o Índice de Proteção em Corredores Estruturais sob Pressão Antrópica (ICEAP  , Equação 6) re-6) re-) re-
presenta uma integração entre o ICEA   e informações sobre a proporção de áreas com alguma pro-
teção legal. Para as UAPs, as zonas de proteção ripária são representadas por diferentes larguras 
de buffer ao longo de rios, que correspondem aos limites das Áreas de Preservação Permanente 
(APPs) estabelecidas no Código Florestal, delimitadas seguindo a metodologia proposta por Jesus 
e Souza (2016). Leva-se, ainda, em consideração a existência de Unidades de Conservação com 
regime de Proteção Integral nas áreas abrangidas pelas UAPs, considerando que a proteção legal 
fornecida pela dimensão da APP nesses ambientes substancialmente excede o disposto na lei, 
englobando toda a zona ripária (500 m). Assim, calcula-se a proporção da superfície ocupada pela 
zona de proteção em cada célula de 1 ha (Pc), que pode ser obtida a partir da sobreposição do buffer 
de APP respectivo sobre as células do grid onde ocorrem as classes “Ponte” e “Habitat Interior”. Em 
seguida aplica-se a fórmula do índice (Equação 6):

Onde:

ICEAc = Índice de Corredores Estruturais sob Pressão Antrópica.

Pc = proporção de áreas com alguma proteção legal na célula c.

c

c
Equação (5)

c

c

Equação (6)
ICEA .

Pc

cICEAP   = 
c
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Tal	 índice	permite	 identificar	quais	as	áreas	que	abrigam	corredores,	mas	não	possuem	grau	ou	
extensão de proteção adequados. Se houver poucas áreas protegidas (no denominador), o valor 
do índice vai aumentar. Altos valores do Índice de Proteção em Corredores Estruturais sob Pressão 
Antrópica (ICEAP   )	correspondem	a	um	alto	ranking	atribuído	à	célula,	indicando	significativa	presen-
ça de corredores ripários estruturais em condições de pressão antrópica e com pouco ou nenhum 
grau de proteção. Células com altos scores do ICEAP   representam regiões prioritárias potenciais 
para a restauração e manejo de corredores ripários.

Para facilitar comparações entre diferentes cenários na mesma UAP ou em UAPs distintas, re-
comenda-se padronizar os índices, gerando escores que variam de 0 a 1. Os índices podem ser 
espacializados e analisados separadamente (Figura 61, Figura 62 e Figura 63). Se o objetivo for 
analisar um conjunto de UAPs (por região, estado, bioma, etc), recomenda-se efetuar a padroniza-
ção considerando os resultados de todas as UAPs do conjunto.

c

c

Figura 61. Distribuição espacial do Índice de Corredores Estruturais (ICEc) para a UAP1214.
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Figura 62. Distribuição espacial do Índice de Corredores Estruturais sob Pressão Antrópica (ICEA   ) para a UAP1214.
C
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Figura 63. Distribuição espacial do Índice de Proteção em Corredores Estruturais sob Pressão Antrópica (ICEA   ) para a 
UAP1214. C

Para a aplicação da metodologia proposta serão necessárias as camadas de informação que con-
tém	a	rede	hidrográfica,	o	mapa	de	uso	e	cobertura	da	terra	e	os	resultados	da	segmentação	resul-
tante da MSPA. 

Para a realização da análise das zonas ripárias deve-se proceder da seguinte forma: 

a. Gerar o buffer de 500 m ao longo dos cursos e massas d’água constantes da camada de in-
formação	da	rede	hidrográfica,	denominado	“buffer_500m” utilizando a ferramenta “Buffer” do 
ArcMap disponível a partir do menu principal, sob o item “Geoprocessing”.

b. Gerar o arquivo vetorial (shapefile) correspondente às Áreas de Preservação Permanente 
(APP), de acordo com a largura dos rios da UAP, seguindo a metodologia proposta por Jesus 
e Souza (2016). Para rios inseridos em Unidades de Conservação (UCs) de Proteção Integral 
deve-se manter o buffer de 500 m ao longo dos rios.

c. Gerar um grid de 100 m x 100 m na forma de polígono para toda a UAP, denominando-a 
“grid_100x100m”, utilizando a ferramenta “Fishnet” do ArcMap, disponível na ArcToolbox sob 
“DataManagement Tools>Sampling>CreateFishnet”. Acrescentar à tabela um campo tipo tex-
to (“COD_CEL”) e copiar os IDs dessa tabela para a nova coluna.
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d. Recortar o mapa de uso e cobertura da terra usando o arquivo “buffer_500m”, nomeando-o 
como “zonas_uso_ripario_500m”.

e. Selecionar na camada de informação “zonas_uso_ripario_500m” apenas os registros corres-
pondentes	às	classes	de	uso	antrópico	(solo	exposto,	 influência	urbana,	agricultura,	pasta-
gem	e	floresta	plantada),	de	forma	que	apenas	as	classes	floresta	natural,	outras	terras	com	
vegetação lenhosa, outras terras com árvores, gramíneas e herbáceas, superfície com água 
e	dunas	e	afloramentos	rochosos	sejam	excluídas	da	seleção.	Armazenar	o	resultado	da	se-
leção em novo arquivo, com nome “uso_antropico_zona_uso_ripario”.

f. Recortar o mapa de uso e cobertura da terra usando o arquivo vetorial correspondente às 
APPs, gerando o arquivo nomeado como “zonas_riparias_protegidas_APP”.

g.	 Codificar	e	converter	para	o	formato	matricial	o	mapa	de	uso	e	cobertura	da	terra	com	tama-
nho de célula igual a 5 metros e executar a segmentação da MSPA (conforme exposto na 
Seção 1.2. Análise Morfológica de Padrões Espaciais para a UAP toda, usando largura de 
borda igual a 30 m (6 pixels), nomeando o arquivo como “UAP_MSPA.tif”.

h. Converter os resultados da segmentação MSPA para o formato vetorial, nomeando o resulta-
do como MSPA.

i. Gerar nova camada de informação selecionando somente as classes Ponte e Habitat Interior, 
nomeando o arquivo como “MSPA_bridge_core”.

j. Fazer um recorte do arquivo “MSPA_bridge_core” usando a camada de informação 
“buffer_500m”, nomeando o arquivo resultante como “MSPA_bridge_core_zona_riparia”. Criar 
um campo de texto na tabela de atributos e preencher todos os registros com a expressão 
“Bridge/Core”.

k. Selecionar os elementos de “grid_100x100m” que fazem intersecção com “MSPA_bridge_core_
zona_riparia” e salvá-los em novo arquivo, nominado “grid_ _uso_ripario_com_bridge_core”.

l. Utilizar a ferramenta “Union” disponível a partir do menu principal, sob o item “Geoprocessing”, 
realizando a união espacial dos arquivos “MSPA_bridge_core_zona_riparia” e “grid_ _uso_ri-
pario_com_bridge_core”, nomeando o arquivo resultante como “union_bridge_core_grid”. 
Calcular a área em hectares para todas as feições, a partir da tabela de atributos, criando um 
novo campo e utilizando a ferramenta “Calculate Geometry” disponível, clicando-se com o 
botão direito do mouse sobre o nome do atributo na tabela de atributos.

m. Selecionar apenas os registros que contenham o marcador “Bridge/Core” a partir da seleção 
por atributos. Calcular a proporção de área ocupada pelas classes “Ponte” e “Habitat Interior” 
na célula de 100 m x 100 m (area_ha).

n. Utilizar a ferramenta “Summarize” para calcular a somatória de proporção por célula a partir 
da coluna ”COD_CEL”. O valor resultante corresponde ao Índice de Corredores Estruturais 
(ICEc) dentro da zona ripária.

o. Recortar a camada de informação “uso_antropico_zona_uso_ripario” utilizando o arquivo 
“grid_ _uso_ripario_com_bridge_core”, gerando o arquivo “uso_antropico_ grid_ bridge_core”. 
Criar um novo campo texto (“CLASSE”) e preencher todos os registros com “Antrópico”.
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p. Utilizando a extensão “Union”, cruzar a camada de informação “uso_antropico_ grid_ bridge_
core” com o arquivo “grid_100x100m_em_uso_ripario_com_bridge_core”, gerando o arquivo 
“union_antropico_grid”. Calcular área em hectares para todas as feições.

q. Selecionar apenas os registros que forem correspondentes a uso antrópico. Calcular a propor-
ção de área ocupada pela classe de uso antrópico em cada célula (area_ha). Calcular a soma-
tória de proporção por célula utilizando a coluna “COD_CEL” com a ferramenta “Summarize” 
do ArcMap. Unir esta tabela àquela contendo o ICEc por meio da função “Join”.

r. Multiplicar o percentual resultante pelo índice ICEc, gerando o Índice de Corredores Estruturais 
sob Pressão Antrópica (ICEA  ). Será obtido um valor para cada célula do grid dentro da zona 
ripária equivalente a 500 m de buffer.

s. Recortar a camada de informação “zonas_riparias_protegidas_APP” utilizando o ar-
quivo “grid_uso_ripario_com_bridge_core”, nomeando o arquivo resultante como 
“APP_em_grid_com_bridge_core”.

t. Utilizar a ferramenta “Union” para a união espacial dos arquivos “APP_em_grid_com_bridge_
core” e “grid_uso_ripario_com_bridge_ core”, nomeando o arquivo resultante como ”union_
APP_grid”. Calcular a área em hectares para todas as feições.

u. Selecionar apenas os registros em que os códigos das classes sejam diferentes de zero, cor-
respondendo às APPs. Fazer o cálculo da proporção da área ocupada pela APP em relação à 
área total da célula do grid (area_ha).

v. Calcular a somatória de proporção por célula utilizando a coluna “COD_CEL” com a ferra-
menta “Summarize” para todos os registros. Unir esta tabela às demais através do comando 
“Join”.

w. Dividir o índice ICEA   pelo percentual resultante, gerando o Índice de Proteção em Corredores 
Estruturais sob Pressão Antrópica (ICEAP  ). Será obtido um valor para cada célula do grid den-
tro da zona ripária equivalente a 500 m de buffer. Haverá divisões por zero, que correspondem 
a áreas dentro da zona ripária de 500 m onde não há proteção legal. Nesse caso, inserir valor 
de proporção = 0,000001 apenas como artifício para evitar a divisão por zero. Os valores do 
índice para essas células serão bastante altos, o que é coerente com a interpretação de que 
existe escassez de áreas protegidas onde ocorrem corredores estruturais ripários representa-
dos por “Pontes” e áreas de “Habitat Interior”, existindo alguma pressão antrópica.

x. O somatório dentro de cada célula do grid representa o valor resultante do índice ICEAP.

y. Para cada UAP, aplicar uma padronização do tipo mínimo-máximo para cada um dos índices, 
exceto o ICEc , usando a Equação 7.

Em que:

Ires c = valor reescalonado (padronizado) para o índice Ic (ICEAc e ICEAP  , separadamente) na 
célula c.

c

c

c

Ic - Imin

Imax - Imin

Ires c = Equação (7)

c
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Ic = índice Ic (ICEAc e ICEAP  , separadamente) na célula c.

Imax = valor máximo para o índice Ic em questão, para o conjunto de dados utilizado.

Imin = valor mínimo para o índice Ic em questão, para o conjunto de dados utilizado.

1.9.1 Índices de corredores e conectores estruturais presentes nas zonas ripárias

As etapas descritas anteriormente para a obtenção dos índices ICEc , ICEA  , ICEAP   fornecem esses 
valores para as células de 1 hectare utilizadas no grid de 100 m x 100 m. Assim, uma UAP terá 
tantos valores para os índices quantas células existirem da interseção desse grid com as áreas de 
“Habitat Interior” e “Ponte” dentro da zona ripária (itens “k” e “l”, resultando no arquivo “union_brid-
ge_core_grid”). De tal maneira, para a obtenção de um valor único, de cada índice, para a UAP, 
deve-se calcular a média dentro dessa amplitude de valores, para cada um dos índices, após a 
padronização	dos	dados.	Dessa	forma,	ao	final	do	processamento	resultarão	três	índices	de	corre-
dores e conectores estruturais ripários presentes na paisagem (Rosot et al., 2018), com um valor 
único por UAP, variando de 0 a 1.

•	 Índice de corredores estruturais (ICEc ): representa a proporção total da superfície ocupada 
pela presença de corredores estruturais em cada célula c de 1 hectare. A quantidade de corre-
dores ripários representada por esse índice é diretamente proporcional à extensão das zonas 
ripárias presentes na célula c.	Isto	significa	que	valores	elevados	para	ICEc ocorrerão em áreas 
com condições que permitam a presença de zonas ripárias, isto é, em áreas com altas propor-
ções	cobertura	natural	e	seminatural	e	uma	densa	rede	fluvial.

•	 Índice de corredores estruturais sob pressão antrópica (ICEA  ): deriva da integração do 
ICEc com	informações	a	respeito	da	proporção	de	cobertura	não	natural	(áreas	artificiais	e	agrí-
colas) presentes na célula. O valor desse índice é elevado quando há uma grande proporção 
da área da célula ocupada por terras urbanizadas ou agrícolas; consequentemente, células 
com valores mais altos indicam situações mais críticas sob uma perspectiva de conservação e 
de gestão das zonas ripárias.

•	 Índice de proteção em corredores estruturais sob pressão antrópica (ICEAP  ): este índice 
considera a proporção de corredores estruturais sob pressão antrópica, bem como informa-
ções sobre a proporção de áreas com algum esquema de proteção (Pc). Para as UAPs, as 
zonas de proteção ripária são representadas pelos limites de APP estabelecidos no Código 
Florestal	de	acordo	com	a	largura	dos	rios,	definidas	seguindo	a	metodologia	descria	por	Jesus	
e	Souza	(2016).	Tal	índice	permite	identificar	quais	as	áreas	abrigam	corredores,	mas	não	pos-
suem grau ou extensão de proteção adequada. Se houver poucas áreas protegidas, o valor 
global do índice irá aumentar. Altos valores para esse índice correspondem a um alto ranquea-
mento	atribuído	à	célula,	indicando	significativa	presença	de	corredores	ripários	estruturais	em	
condições de pressão antrópica e com pouco ou nenhum grau de proteção. Células com altos 
valores de ICEAP   representam regiões prioritárias potenciais para a restauração e manejo de 
corredores ripários.

Para a UAP1214, utilizada como exemplo nesse manual, os valores de índices obtidos são apre-
sentados na Tabela 16, a seguir.

c

c c

c

c

c
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1.10	Diagnóstico	final	-	qualidade	da	paisagem	florestal

A	qualidade	da	paisagem	florestal	das	UAPs	em	termos	de	sua	estrutura,	composição	e	configu-
ração espacial é avaliada por meio de indicadores e representada por sete grupos de índices. A 
combinação linear dos índices selecionados, atribuindo-lhes diferentes pesos, gera um valor único 
por UAP, o que permite estabelecer comparações entre elas e priorizar aquelas onde ações de 
recuperação, manutenção ou melhorias relativas a determinados aspectos da paisagem são mais 
necessárias. Os índices mais representativos selecionados dentro de cada grupo foram:

a. Composição da paisagem: soma das proporções de cobertura arbórea e/ou arbustiva 
(“Floresta Natural”; “Outras Terras com Vegetação Lenhosa”; “Outras Terras com Árvores”) 
e outras áreas naturais/seminaturais (“Gramíneas e Herbáceas” e “Floresta Plantada”) para 
cada UAP.

b. Modelo de padrão morfológico: proporção de áreas de habitat interior (core) no primeiro 
plano da UAP; ou seja, áreas pertencentes a classes naturais com cobertura arbórea e/ou 
arbustiva, localizadas além da distância de 30 metros de borda de outras classes (segundo 
plano).

c. Modelo de mosaico da paisagem: proporção de classes de mosaico de padrão natural (clas-
se NN + N); ou seja, áreas de cobertura arbórea/arbustiva com, no mínimo, 80% de vizinhan-
ça	natural/seminatural,	e	menos	de	10%	de	áreas	artificiais	ou	com	agricultura	e	pastagem,	
em seu entorno imediato (dentro de um raio de aproximadamente 50 m).

d. Modelo de interface de bordas: proporção de bordas dos fragmentos de cobertura arbórea/
arbustiva com interface natural (BONN).

e. Modelo de conectividade da paisagem: índice de probabilidade de conectividade (PC); pro-
babilidade de que dois pontos, colocados aleatoriamente dentro da paisagem, se localizem 
em áreas que são acessíveis entre si.

f. Fragmentação na paisagem: índice de fragmentação do primeiro plano da paisagem.

g. Análise dos corredores e conectores estruturais em zonas ripárias na paisagem: índice 
de corredores estruturais sob pressão antrópica sob algum esquema de proteção (ICEAP  ) em 
zonas	de	influência	ripária.

Cada índice individualmente foi submetido a uma padronização “mínimo-máximo”, por meio da 
Equação 8:

c

(xi - xmin)

(xmax - xmin)
xpad = Equação (8)

Tabela 16. Índices de corredores e conectores estruturais ripários na paisagem da UAP1214.

Índices Valor
Índice de corredores estruturais (ICEc) 0,6451
Índice de corredores estruturais sob pressão antrópica (ICEA  ) 0,0503
Índice de proteção em corredores estruturais sob pressão antrópica (ICEAP  ) 0,0023

c

c
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Em que:

xpad : novo valor, padronizado, para a variável x.

xmax : máximo valor da variável x para o conjunto de dados.

xmin : mínimo valor da variável x para o conjunto de dados.

xi : valor original da variável x.

Assim, para cada UAP devem ser somados os valores normalizados das sete variáveis (índices), 
por meio da Equação 9.	O	valor	final	deve	ser	calculado	reescalonando	essas	somatórias	em	uma	
escala de 0 a 10.

S = (a x 1,5) + b + c + (d x 1,5) + e + (1 - f) + (1 - g)

Em que:

a : índice de composição da paisagem.

b : índice do modelo de padrão morfológico do habitat.

c : índice do modelo de mosaico da paisagem.

d : índice do modelo de interface de bordas.

e : índice do modelo de conectividade da paisagem.

f : índice de fragmentação.

g : índice de corredores e conectores estruturais nas zonas ripárias.

Para	os	 índices	mais	 importantes	na	 identificação	da	qualidade	do	componente	florestal	na	pai-
sagem	foram	atribuídos	pesos	mais	altos	no	cálculo	da	nota	final,	sendo	1,5	para	a	proporção	de	
áreas naturais e seminaturais na UAP e também 1,5 para a proporção de bordas com interface na-
tural (BONN). Para os demais índices o peso foi considerado igual a 1, exceto no caso do índice de 
fragmentação do primeiro plano e do índice de proteção em corredores estruturais sob pressão an-
trópica (ICEAP  ),	cujos	valores	influenciam	os	cálculos	de	forma	inversamente	proporcional	quando	
comparados	aos	demais	–	ou	seja,	quanto	mais	alto	o	valor,	pior	a	qualidade	da	paisagem	florestal	
para	o	índice	avaliado,	não	podendo	ser	adicionados	diretamente	à	nota	final.	Estes	valores	entra-
ram	com	o	sinal	invertido	na	conta	da	nota	final.	

Equação (9)

c
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